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Figures and illustrations in this User Manual are provided for reference only and may differ from actual product 
appearance. Product design and specifications may be changed without notice.

Instruction
This TV is provided with interactive functionality through a set-back box (SBB/STB) connected to the TV, and with other TVs in a 
computer-controlled system for hotels and other hospitality businesses. 
Interactive: When the TV is powered-up initially, it sends a command to identify the SBB/STB; if identified, theTV switches to 
ONLINE mode and full control is through the SBB/STB.
If the TV is in ONLINE mode, it stops receiving IR(Samsung remote) commands and acts according to interface protocol. 
Stand-Alone: If SBB/STB is not identified, the TV should be switched to STAND-ALONE mode with restricted operation.

Operational Modes
When this TV (in Hotel mode) is operated with a SBB/STB, it is in one of two states :
•	 ONLINE or STAND-ALONE. In the STAND-ALONE state, the TV will act as a Hotel TV, but without active communication. 

This is to prevent guests from trying to cheat the system by disconnecting the SBB/STB. 

To set the details for Stand-alone or interactive mode, refer to pages 19-22(Setting the hotel option data : Stand-alone 
mode and Interactive mode)
•	 Some operations may be restricted to prevents guests from "cheating" the TV system.
•	 No main menu(Interactive mode) or Channel Menu, Plug & Play in Main Menu (Stand-Alone mode)
•	 Limited Volume and Panel key lock or unlock

Still image warning
Avoid displaying still images (like jpeg picture files) or still image element (like TV Program logo, panorama or 4:3 image format, 
stock or news bar at screen bottom etc.) on the screen. Constant displaying of still picture can cause uneven wear of screen 
phosphor, which will affect image quality. To reduce risk of this effect, please follow below recommendations:
•	 Avoid displaying the same TV channel for long periods.
•	 Always try do display any image on full screen, use TV set picture format menu for best possible match.
•	 Reduce brightness and contrast values to minimum required to achieve desired picture quality, exceeded values may speed 

up the burnout process.
•	 Frequently use all TV features designed to reduce image retention and screen burnout. Refer to the relevant user manual 

section for details.

Securing the Installation Space
Keep required distances between the product and other objects (e.g. walls) to ensure proper ventilation.
Failing to do so may result in fire or a problem with the product due to an increase in the internal temperature.

 ✎ When using a stand or wall-mount, use parts provided by Samsung Electronics only.
•	 Using parts provided by another manufacturer may result in a problem with the product or injuries due to the product falling.

 ✎ The appearance may differ, depending on the product.

Installation with a stand. Installation with a wall-mount.

10 cm10 cm

10 cm

10 cm10 cm

10 cm

10 cm

Power
ON

Hotel TV

Online Mode
Poll Rate 20/sec

Stand-alone 
ModeHotel Mode On SBB/STB Online if 

one success within 
10 attempts

SBB/STB 
Online-10 

consecutive 
fails

SBB/STB 
Status-
Attempt 
every 2secs
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Accessories

 ✎ Please make sure the following items are included with your LED TV. If any items are missing, contact your dealer.
 ✎ The items’ colour and shapes may vary depending on the model.

•	 Remote Control & Batteries (AAA x 2) 
•	 Quick Set up Guide
•	 CI Card Adapter
•	 Hotel Mount Kit

•	 Power Cord / Data Cable
•	 Safety Guide (Not available in all locations)
•	 Cable Holder

 ✎ The stand and stand screw may not be included, depending on the model.
 ✎ The Data Cable may not be included, depending on the SI Vendor.

Correct Disposal of This Product (Waste Electrical & Electronic Equipment)
(Applicable in the European Union and other European countries with separate collection systems)
This marking on the product, accessories or literature indicates that the product and its electronic 
accessories (e.g. charger, headset, USB cable) should not be disposed of with other household waste 
at the end of their working life. To prevent possible harm to the environment or human health from 
uncontrolled waste disposal, please separate these items from other types of waste and recycle them 
responsibly to promote the sustainable reuse of material resources. Household users should contact either 
the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling. Business users should contact their 
supplier and check the terms and conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for disposal.

Correct disposal of batteries in this product
(Applicable in the European Union and other European countries with separate battery return 
systems.)
This marking on the battery, manual or packaging indicates that the batteries in this product should not 
be disposed of with other household waste at the end of their working life. Where marked, the chemical 
symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium or lead above the reference 
levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm 
to human health or the environment. To protect natural resources and to promote material reuse, please 
separate batteries from other types of waste and recycle them through your local, free battery return 
system.
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Installing the LED TV Stand

The 32” and larger LED TVs have swivel stands. You can set these stands so that the TVs swivel 20 degrees left and 
right or 90 degrees left and right.

Stand Components

When installing the stand, use the provided components and parts.

28" 32" ~ 55"

1 EAA B 1 EA

28"

32"

40" ~ 55"

C

D

28" ~ 32"

40" ~ 55"

x7 (M4 X L12)

x8 (M4 X L12)

•	 Stand •	 Guide Stand •	 Screws 

HG28EC690 

3 Tight the bottom of the screw first, and stow the 
upper side of screw last.

4 When the declination happened, try reassemble 
it 2  category.

C

(M4 X L12) 

 x3

2

 ✎ Place a soft cloth over the table to protect the TV, and then place 
the TV on the cloth screen-side down.

 ✎ Insert the Stand Guide into the slot on the bottom of the TV.
 ✎ Slide and assemble it to the end line in the direction of arrow.

3-1 3-2

 ✎ Progress the assembly of screw in the manual’s order. 

 ✎ Make sure to assembling stand guide attached on the TV. 

2-32-1 2-2

1

1-1

A

B

1-3

C
(M4 X L12) 

 x4

1-2
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HG32EC690 / HG40EC690 / HG48EC690 / HG55EC690

3 Tight the bottom of the screw first, and stow the upper side of screw last.

4 When the declination happened, try reassemble it 2  category.

2

 ✎ Place a soft cloth over the table to protect the TV, and then 
place the TV on the cloth screen-side down.

 ✎ Insert the Stand Guide into the slot on the bottom of the TV.
 ✎ Slide and assemble it to the end line in the direction of arrow.

3-1

3-2

 ✎ Progress the assembly of 
screw in the manual’s order. 

 ✎ Make sure to assembling stand guide attached on the TV. 

2-32-1 2-2

1 C
(M4 X L12) 

 x4

A

1-1

1-3

1-2

B

C 32"

 x3 (M4 X L12)

D 40" ~ 55"

 x4 (M4 X L12)

 ✎ NOTE
 y Make sure to distinguish between the front and back of each component when assembling them.
 y Make sure that at least two persons lift and move the TV.
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Assembling the swivel (32 inch TVs or larger)

 ] WARNING: If you configure the TV to swivel, you must attach it securely to the floor, a desk, a dresser top, etc. as 
described in the installation instructions.

The 32” and larger LED TVs have swivel stands. You can configure these stands so that the TVs swivel 20 degrees left and 
right, 60 degrees left and right, or 90 degrees left and right using the BRACKET HOLDER SWIVEL.

 ¦ 20° swivel

To configure the TV so that it swivels 20° left and right, insert the prong on the bottom of the stand through the curved hole 
in the Bracket Holder Swivel marked 20°. Then, fix the Bracket Holder Swivel to the stand using the three supplied screws as 
shown below.

 ¦ 60° swivel

To configure the TV so that it swivels 60° left and right, insert the prong on the bottom of the stand through the curved hole 
in the Bracket Holder Swivel marked 60°. Then, fix the Bracket Holder Swivel to the stand using the three supplied screws as 
shown below.

 ¦ 90° swivel

To configure the TV so that it swivels 90° left and right, remove the Bracket Holder Swivel, and then screw the three supplied 
screws into the stand as shown below.
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 ¦ Hotel Mount Kit

Affix the stand to a flat surface such as a 
dresser top, desk top, or entertainment center as 
shown. 

[ WARNING: To prevent injury, you must attach this TV securely to the floor, a table, a dresser top, etc. with 
the Hotel Mount Kit as described in these instructions.

Short Bolt (2EA) Long Bolt (2EA) Nut (2EA) Washer (2EA)

Bolt + Nut

Top

Bottom
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Viewing the Connection Panel

 ✎ Whenever you connect an external device to your TV, make sure that power on the unit is turned off.
 ✎ When connecting an external device, match the colour of the connection terminal to the cable.

HG32EC690**
HG40EC690**
HG48EC690**
HG55EC690**

HG28EC690**
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1 AV IN
 – Connect audio cables to "R-AUDIO-L" on your TV and the other ends to corresponding audio out jacks on an 

A/V device.
 – Connects Component video / audio.
 – Connect RCA audio cables (optional) to "R - AUDIO - L" on the rear of the TV set and the other ends to 

corresponding audio out jacks on the external device.
 – When connecting to AV IN, the color of the AV IN [Y/VIDEO] jack (Green) does not match the color of the video 

cable (Yellow).

2 USB (5V 0.5A) / CLONING 
USB (HDD/1.0A) / CLONING

 – Connector for software upgrades and Media Play, etc.
 – Service connection.

3 HDMI IN 1, 2(DVI), 3(ARC): Connects to the HDMI jack of a device with an HDMI output.
 ✎ No sound connection is needed for an HDMI-HDMI connection. HDMI connections carry both audio and video. 
 ✎ Use the HDMI IN 2(DVI) jack for a DVI connection to an external device. Use a DVI to HDMI cable or DVI-HDMI 
adapter (DVI to HDMI) for the video connection and the PC/DVI AUDIO IN jacks for audio.

4 ANT IN (SATELLITE), (AIR/CABLE)
 – To view television channels correctly, the TV must receive a signal from one of the following sources:
 – An outdoor antenna / A cable television system 

5 HEADPHONE JACK: Headphones may be connected to the headphone jack on your TV. While the headphones 
are connected, the sound from the built-in speakers is disabled.

6 HP-ID: Connect the cable to HP-ID and Headphone Jack simultaneously and connect it to separated Headphone 
Box. See page 18. When connecting Headphone to Headphone Box, it works same as Headphone function.

Display Modes

You can also select one of the standard resolutions listed in the Resolution column. The TV will automatically adjust to 
the resolution you choose.
After connecting a computer to the TV, set the screen resolution for the TV on the computer. The optimal resolution is 
1920 x 1080 @ 60 Hz. If it is set to any other than in the table below, the TV may display nothing. Set the resolution 
properly, referring to the user guide of the computer or its graphic card.
The resolutions in the table are recommended.

 ✎ Optimal resolution is 1366 X 768 @ 60 Hz. 

Mode Resolution
Horizontal Frequency 

(KHz)
Vertical Frequency 

(Hz)
Pixel Clock Frequency

(MHz)
Sync Polarity 

(H / V)

IBM
640 x 350
720 x 400

31.469
31.469 

70.086
70.087 

25.175
28.322

+/-
-/+

MAC
640 x 480
832 x 624

35.000
49.726

66.667
74.551

30.240
57.284

-/-
-/-

VESA CVT
720 x 576

1280 x 720
35.910
56.456

59.950
74.777

32.750
95.750

-/+
-/+

VESA DMT

640 x 480
640 x 480
640 x 480
800 x 600
800 x 600
800 x 600

1024 x 768
1024 x 768
1024 x 768
1280 x 720
1366 x 768

31.469
37.500
37.861
37.879
46.875
48.077
48.363
56.476
60.023
45.000
47.712

59.940
75.000
72.809
60.317
75.000
72.188
60.004
70.069
75.029
60.000
60.015

25.175
31.500
31.500
40.000
49.500
50.000
65.000
75.000
78.750
74.250
85.500

-/-
-/-
-/-
+/+
+/+
+/+
-/-
-/-
+/+
+/+
+/+

VESA GTF 1280 x 720 52.500 70.000 89.040 -/+ 
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 ✎ Optimal resolution is 1920 X 1080 @ 60 Hz.

Mode Resolution
Horizontal Frequency 

(KHz)
Vertical Frequency 

(Hz)
Pixel Clock Frequency

(MHz)
Sync Polarity 

(H / V)

IBM 720 x 400 31.469 70.087 28.322 -/+

MAC
640 x 480
832 x 624

1152 x 870

35.000
49.726
68.681 

66.667
74.551
75.062

30.240
57.284

100.000

-/-
-/-
-/-

VESA DMT

640 x 480
640 x 480
640 x 480
800 x 600
800 x 600
800 x 600

1024 x 768
1024 x 768
1024 x 768
1152 x 864

1280 x 1024
1280 x 1024
1280 x 720
1280 x 800
1280 x 960
1366 x 768
1440 x 900

1600 x 900RB
1680 x 1050
1920 x 1080

31.469
37.861
37.500
37.879
48.077
46.875
48.363
56.476
60.023
67.500
63.981
79.976
45.000
49.702
60.000
47.712
55.935
60.000
65.290
67.500

59.940
72.809
75.000
60.317
72.188
75.000
60.004
70.069
75.029 
75.000
60.020
75.025
60.000
59.810
60.000
60.015
59.887
60.000
59.954
60.000

25.175
31.500
31.500
40.000
50.000
49.500
65.000
75.000
78.750

108.000
108.000
135.000
74.250
83.500

108.000
85.500

106.500
108.000
146.250
148.500

-/-
-/-
-/-
+/+
+/+
+/+
-/-
-/-
+/+
+/+
+/+
+/+
+/+
-/+ 
+/+
+/+
-/+ 
+/+
-/+
+/+

 ✎ When using an HDMI/DVI cable connection, you must use the HDMI IN 1 (DVI) jack.
 ✎ The interlace mode is not supported.
 ✎ The set might operate abnormally if a non-standard video format is selected.
 ✎ Separate and Composite modes are supported. SOG is not supported.
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7 RJP: This port is an RJP (Remote Jack Pack) communication port that enables connecting different devices to 
additional modules to improve device use and convenience.

8 PC/ DVI AUDIO IN: Connects to the audio input jacks on an Amplifier/Home Theater.

9 VOL-CTRL: Used to control the volume of the Bathroom speaker. Connect the Bathroom Wall Box and the 
VOLCTRL port.

0 VARIABLE AUDIO OUT: Used for the audio output to the Bathroom speaker. Connect the Bathroom Wall Box and 
the Variable port (RCA).

! CLOCK: Set the time after connecting the cable of the External Clock to Clock jack. You can use the External Clock 
Display function.

@ DATA
 – Used to support data communication between the TV and the SBB.
 – Connects using RJ-12 TV type plugs.

# PC IN: Connect to the video output jack on your computer.

$ LAN: Connect to a wired LAN using CAT 5 cable.

Caution of the cover-jack

 [ CAUTION
The cover-jack is for use by qualified service personnel only.
To reduce the risk of electric shock or fire hazard, do not use the cover jack, unless you are qualified to do so.

TV Rear Panel

Cover-jack

 ✎ The rear panel may differ depending on the model.
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TV Controller

TV Controller is a multi directional button that helps navigate without using the remote control.
 ✎ Some functions which require a PIN code may not be available.
 ✎ The product colour and shape may vary, depending on the model. 
 ✎ Exits the menu when pressing the controller for more than 1 second.
 ✎ When selecting the function by moving the controller to the up/down/left/right directions, do not press the controller. 
If the controller is used first, you cannot operate it to move the up/down/left/right directions.

Power on Turn the TV on by pressing the controller in standby mode.

Adjusting the volume Adjust the volume by moving the controller from side to side when the power is 
on.

Selecting a channel Select a channel by moving the controller up and down when the power is on.

Using the function menu Press the controller when the power is on and the function menu appears. If you 
press it again, the function menu screen disappears.

Using the Menu Selects the MENU(m) by moving the controller in the function menu screen. The 
OSD(On Screen Display) of your TV’s feature appears.

Selecting the Source Selects the Source(s) by moving the controller in the function menu screen. 
The Source list screen appears.

Selecting the SMART 
HUB ( ™ )

With the Function menu visible, select SMART HUB (™) by moving the Controller 
upwards. The SMART HUB main screen appears. Select an application by 
moving the Controller, and then pressing the Controller.

Power Off Selects the Power Off(P) to turn the TV off by moving the controller in the 
function menu screen.

 ✎ To close the Menu, SMART HUB, or Source, press the Controller for more than 1 second.

Standby mode

Do not leave your TV in standby mode for long periods of time a small amount of electric power is still consumed even 
when the power button is such as when on holiday. off. It is best to unplug the power cord.

TV Controller

Function menu

Remote control sensor

The image is drawn by facing 
the front side of the TV.
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Viewing the Remote Control

 ✎ This remote control has Braille points on the Power, Channel, and Volume buttons and can be used by visually 
impaired persons.

GUIDE

CONTENT

CLOCK

ALARM

A B C D

ALARM SUBT.

CLOCK

GUIDE

CONTENTHOME

CH LIST

TTX/MIX

Turns the TV on and off.

Have direct access to channels

Alternately selects Teletext, Double or Mix.

Adjust the volume.

Display channel list on the screen.

Display the main on-screen menu.

Quickly select frequently used functions. 

Select on-screen menu items and 
change menu values.

Return to the previous menu.

Buttons in the Channel list, Contents 
Home menu, etc.

Enter the hour your want the TV to 
turn on.

Use these buttons in the Contents 
Home.

Display and select available video sources.

Electronic Programme Guide (EPG) display.

Cut off the sound temporarily.

Change channels.

Swich to the HOME Screen.

View the Contents Home.

Press to display information on the TV 
screen. 

CLOCK: When you press INFO key 
in standby mode, TV screen displays 
the time.

Exit the menu.

ALARM: Enter the hour you want the TV 
to turn on.

W: Turns the 3D image on or off. ( Not 
available )

SUBT.: Displays digital subtitles.
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Connecting the TV with SBB

1. Connect the DATA jack of the TV to the [ETH MODEM] jack of the STB (SBB) with the Data cable.
 ✎ Use data communication.

ETH MODEM

TV Rear Panel

 Data Cable

Installing batteries (Battery size: AAA)

 ✎ NOTE
•	 Use the remote control within 23 feet of the TV.
•	 Bright light may affect the performance of the remote control. Avoid using nearby special fluorescent light or neon 

signs.
•	 The colour and shape may vary depending on the model.
•	 Remote control button 'HOME' & '3D' are not supported. When pressing these buttons, the TV unit does not 

respond.
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 ¦ List of Vendors and Compatible Data Cables Supplied with the TV

•	 Confirm that you are using the correct data cable for your vendor. Refer to the code label on the data cables.
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Connecting the Bathroom Speakers

You can connect the Bathroom Speakers using the following method.

 ¦ Connecting through the Variable Output (available without an external amplifier)

1. Connect the VARIABLE AUDIO OUT port of the TV to the Bathroom Wall Speakers of the hotel.

Speaker +

Speaker - N/C

2. Connect the VOL-CTRL jack of the TV to the Volume Control Box Switch port on the Bathroom Wall of the hotel.
 ✎ The maximum speaker output is 4W, 8Ω.
 ✎ The VARIABLE AUDIO OUT port supports MONO sound out only.

•	 Installing the Volume Control
 – If you configure the Volume Control Box as shown in the figure, you can control the volume of the bathroom 

speakers.
 – The jack that connects the Volume Control Box to the TV is a 3.5mm normal Phone jack.
 – Volume Control Box switch is a Tact switch.

 ✎ Setting the Sub AMP Mode
 – 0: Turns the Sub AMP function off (PWM off).
 – 1: Determines the Sub volume according to the main volume control. the sub volume is determined according to 

the Power On Volume, the Min Volume, and the Max Volume values of Hotel Mode.
 – 2: Determines the volume according to the bathroom control panel setting.

•	 Variable Output Port Specifications
 – Speaker Wire: Use speaker cable no more than 82 feet (25m) in length.

Volume Control Box

VOL - DOWN 
( White 1 )

VOL - UP 
( Black /Red 2 )

GND 
( Shield Wire 3 )

VOL +

VOL -

1

2

3

VOL+

VOL-

TV Rear Panel

Volume Control Box

Speaker

2

1
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 ¦ Audio Loop In

An additional Headphone Box can be installed on a bed or business desk for added convenience. The installation 
procedures are given below.

•	 Detailed Drawing of the Headphone Box.

TV Headphones jack

Whitewire (Audio-L)

Shield Wire 

TV HP-ID jack

Red wire + White wire

Red Wire (Audio-R)

Shield wire

HEADPHON BOX

TV Rear Panel

Headphone Box

<Headphone Box> 
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Connecting the MediaHub HD

Output to any external source connected to MediaHub HD on the hotel desk.

1. Connect the RJP port of the TV and the RS/232 port of the MediaHub HD.

2. Connect the HDMI IN 1, 2(DVI) or 3 (ARC) port of the TV and the HDMI port of the MediaHub HD.

•	 MediaHub HD
 – The MediaHub HD is a hardware module that has different Audio Video inputs (A/V, Audio, PC, HDMI and USB) 

and corresponding outputs. The corresponding output sources connect from MediaHub to the TV. MediaHub 
communicates with the TV via RS232. Hot Plug & Play is a function that allows hotel guests to connect an 
external source to the MediaHub. MediaHub communicates with the TV by sending messages regarding Active/
Inactive sources. The TV switches to the Active external source.

 – You have to connect the HDMI of the MediaHub to the HDMI IN 2(DVI) port of the TV.
 – When the TV is on, connect the TV and the RJP within 10 seconds.

•	 Special features
 – PIP
 – Auto Detection

HDMI USB RS/232

TV Rear PanelMediaHub HD Rear

2  HDMI cable

1  RS-232 Data Cable
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Connecting the RJP (Remote Jack Pack)

Output to any external source connected to RJP on the hotel desk.

1. Connect the PC IN / PC/DVI AUDIO IN port of the TV to the PC/AUDIO port of the RJP.

2. Connect the AV IN [VIDEO]/[L-AUDIO-R] port of the TV to the VIDEO port of the RJP.

3. Connect the AV IN [VIDEO] port of the TV to the VIDEO port of the RJP.

4. Connect the HDMI IN (1(ARC), 2(DVI) or 3) port of the TV and the HDMI port of the RJP.

5. Connect the RJP port of the TV and the RS/232 port of the RJP.
 ✎ The RJP (Remote Jack Pack) compatible with this Samsung TV is TeleAdapt TA-7610, TA-7650 (HD) and TA-
7660 (HD Plus).

•	 RJP (Remote Jack Pack): RJP stands for Remote Jack Pack. The RJP is a hardware module that has different Audio 
Video inputs (A/V, Audio, PC and HDMI) and corresponding outputs. The corresponding output sources are con-
nected from RJP to TV. The RJP communicates with the TV via RS232. Hot Plug & Play is a function that allows hotel 
guests to connect an external source to the RJP. The RJP communicates with the TV by sending messages regarding 
Active/Inactive sources. The TV will switch to the Active external source according to the priority set by the User. 

 ✎ You can select HDMI IN 1, 2(DVI) or 3(ARC) and AV IN for connecting RJP.
 ✎ When the TV is on, connect the TV and the RJP within 10 seconds.

USB HDMI VIDEO AUDIO AUDIO/PC

RS/232

TV Rear Panel

RJP Rear
5

1  D-sub / PC Audio cable

2  Audio Cable

3 Video Cable

4  HDMI cable
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•	 The RJP can be returned to the factory default settings by pressing the A/V and HDMI buttons simultaneously for 10 
seconds. All LEDs blink 5 times to acknowledge that this has been finished.

•	 The RJP will automatically turn off any LEDs after 5 minutes to avoid unnecessary light pollution in the hotel room. 
The LEDs that were turned off will turn on again if the guest touches any of the buttons and the 5 minute timer will 
restart. If the guest then touches another source button, the TV will change to the selected source and the corre-
sponding LED will be lit.

•	 After an RJP Reset or a TV Power OFF/ON, it takes approx. 10 seconds to establish communications between the 
TV and the RJP.

•	 The following table shows the approximate time in seconds to switch from the TV to the input source, based on the 
priority. 

 ✎ Scenario 1: When no inputs are connected. 

Source To Connect

AV 2 Sec
PC 0.7 Sec

HDMI 3.9 Sec

 ✎ Scenario 2: When two or more inputs are connected and an Input source is disconnected and then reconnected. 

Source Disconnect To Connect Total

AV 4.5 Sec 2 Sec 6.5 Sec
PC 0.7 Sec 0.7 Sec 1.4 Sec

HDMI 3.9 Sec 3.9 Sec 7.8 Sec

 ✎ E.g. If the RJP has all its live sources AV, PC and HDMI connected, AV is viewed as the highest priority. If the RJP 
is in HDMI mode, and a guest removes and reconnects the AV, the minimum time required to switch to the AV is 
6.5 seconds.

•	 To connect audio (Ipod or Mp3), Music mode should be ON and Jack Ident detect should be OFF.
•	 A/V, PC and HDMI input sources are supported.
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Connecting to a COMMON INTERFACE slot (Your TV viewing Card Slot)

 ✎ Scenario 1: When no inputs are connected.

Attaching the CI Card Adapter

Attach the adapter as shown side.
 ✎ To install the CI CARD Adapter, please remove the sticker attached to the TV.

To connect the CI CARD Adapter, follow these steps.
 ✎ We recommend attaching the adapter before installing the wall mount, or 
inserting the “CI or CI+ CARD”.

1. Insert the CI CARD Adapter into the two holes on the product 1.
 ✎ Please find two holes on the rear of the TV, beside the COMMON 
INTERFACE port.

2. Connect the CI CARD Adapter into the COMMON INTERFACE port on 
the product 2.

3. Insert the “CI or CI+ CARD”.

We recommend that you insert the CI card before you mount the TV on a wall. It may be difficult to insert after mounting. Insert the 
card after attaching the CI Card Adapter on TV. It is difficult to attach the module if you insert the card before attaching.

Using the “CI or CI+ CARD”

To watch paid channels, the “CI or CI+ CARD” must be inserted.

•	 If you don’t insert the “CI or CI+ CARD”, some channels will display the mes-

sage “Scrambled Signal”.

•	 The pairing information containing a telephone number, the “CI or CI+ CARD” 

ID the Host ID and other information will be displayed in about 2~3 minutes. If 

an error message is displayed, please contact your service provider.

•	 When the configuration of channel information has finished, the message “Up-

dating Completed” is displayed, indicating the channel list is updated.

 ✎ NOTE

•	 You must obtain a “CI or CI+ CARD” from a local cable service provider.

•	 When removing the “CI or CI+ CARD”, carefully pull it out with your hands since dropping the “CI or CI+ CARD” 

may cause damage to it.

•	 Insert the “CI or CI+ CARD” in the direction marked on the card.

•	 The location of the COMMON INTERFACE slot may be different depending on the model.

•	 “CI or CI+ CARD” is not supported in some countries and regions; check with your authorized dealer.

•	 If you have any problems, please contact a service provider.

•	 Insert the “CI or CI+ CARD” that supports the current aerial settings. The screen will be distorted or will not be 

seen.

TV Rear
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Setting the Hotel Option Data

To Enter: Press the MUTE → 1 → 1 → 9 → ENTERE buttons in order. (From the Hospitality mode, the Standalone mode is set.)
To Exit from this menu : power off and turn on again.

 ✎ Depending on Model and Region, some menus do not exist on the TV set.

Hotel TV Function
Description

Category Item initial value

Hospitality Mode Hospitality Mode Standalone
Select Hospitality mode.
•	 Interactive mode : TV works with an SI STB or SBB.
•	 Standalone mode : TV works alone, without an SI STB or SBB.

SI Vendor SI Vendor OFF
•	 Interactive mode : Samsung / OCC / MTI / Nstreams / Enseo / Cardinal / 

Guestek / Seachange / MDC / Innvne
•	 Standalone mode : Smoovie

Power On

Power On Channel Last Saved

Set the default values that will be applied when the TV is turned on.
•	 User Defined : Lets you set Power On Channel and Channel Type manually. 

See Power On Channel and Channel Type below.
•	 Last Saved : If you select this item, when the TV is turned on, it displays the 

channel it was displaying when it was turned off.

Power On Channel 
Num

1 When the TV is turned on, it switches automatically to this channel.

Power On Channel 
Type

ATV Select channel band : AIR (analog air band), DTV (digital air band), CATV (analog 
cable band), CDTV (digital cable band)

Power On Volume Last Saved

•	 User Defined : Lets you set the Power On Volume manually. See Power On 
Volume below.

•	 Last Saved : When the TV is turned on, it returns to the volume that had been 
set when the power had been turned off.

Power On Volume 
Num

10 The TV turns on with this Volume Level in Stand Alone Hospitality mode.

Min Volume 0 The minimum Volume Level the user can set in Stand Alone Hospitality mode.

Max Volume 100 The maximum Volume Level the user can set in Stand Alone Hospitality mode.

Power On Source TV Select the input source the TV displays when turns on.

Power On Option Last Option

Determines the TV's state when power returns after a power failure or after you 
have unplugged the TV and then plugged it in again.
•	 LAST Option : Returns to its last Power state. If it was in Stand-by, it returns 

to Stand-by. If it was on, it turns on.
•	 Power On : When the power returns, the TV turns on.
•	 Standby : When the power returns, the TV enters the Standby mode.

Channel

Channel Setup Gives you direct, immediate access to some of the Channel menu functions on 
the user Channel menu such as Auto Program, Antenna selection, etc.

Channel Editor

The Channel Editor lets you edit the channels stored in the TV's memory. Using 
Channel Editor you can:
•	 Change the channel numbers and names, and sort the channels in your 

desired channel number order.
•	 Apply the video mute to channels you select. The video mute blanks out 

the video from a channel and outputs only the sound while displaying a 
speaker icon on the screen.

The Channel Editor also lets you view information about each channel easily, 
without your having to display each channel directly.

Mixed Channel
Map

ON

This Feature enables showing/browsing all antenna type (Air/Cable or Satellite) 
channels at the same time.
•	 On: When ON, guests can access the complete Channel Map irrespective 

of the selected antenna type. The Channel list will also populate Air as well 
Cable type channels.

•	 Off: When OFF, guest can access the Channel Map corresponding to the 
selected antenna type [AIR/CABLE or Satellite] only. The Channel list/
Editor will only show the selected antenna type channels.

Dynamic SI OFF

•	 On : Check the DTV Programme channel number. (the DTV channel editor 
is inaccessible)

•	 Off: Do not check the DTV Programme channel number. 
(the DTV channel editor is accessible, but additional channel Programme 
number update is not supported)
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Hotel TV Function
Description

Category Item initial value

Channel

Channel Rescan 
Message

ON

When there is a mismatch between the data in the channel map and the 
transmitted data , the TV autotunes the channels to restore the data/parameters 
in the channel map.
•	 On: When Channel Rescan Message is ON, The OSD showing that the 

channels are being rescanned will be displayed to Hotel Guests.
•	 Off: A Hotel Admin can turn the Channel Rescan Message OFF, if the 

rescan message OSD should not to be displayed to Hotel Guests.

Pan Euro MHEG OFF

•	 Off: If Pan EURO MHEG is set to Off, MHEG runs according to the exist-
ing product specifications.

•	 ON: If Pan EURO MHEG is set to On, MHEG is ON regardless of the 
product specifications or region.

My Channel OFF Enable or disable the Mychannel feature.

Genre Editor … Edit the genre for channels. (Available when Mychannel is On)

Subtitle Auto On OFF

This function turns the function On/Off that automatically turns on the subtitles in 
a specific country.
This function is supported for Hotel TVs that are ready to receive DVB broadcasts 
that is heading to Europe.
This function is related to France’s subtitle specification. The rest of the countries’ 
subtitles function according to the appropriate country specifications regardless of 
the Subtitle Auto On function.
•	 On: When the Subtitle Auto On function is ON, it follows France’s subtitle 

specifications.
•	 Off: When the Subtitle Auto On function is OFF, it does not follow France’s 

subtitle specifications.

Menu OSD

Picture Menu Lock OFF Enable or disable the Picture Menu.

Menu Display ON •	 On : The Main Menu is displayed.
•	 Off : The Main Menu is not displayed.

Panel Button Lock Unlock

Turning the front panel (local key) operations on/off.
•	 Unlock : Unlocks all panel keys.
•	 Lock : Locks all panel keys.
•	 OnlyPower : Locks all panel keys except the Power panel key.
•	 Menu/Source : Locks the Menu and Source panel keys.

Home Menu 
Display

ON OFF:The Home Menu is not displayed. 
ON:The Home Menu is displayed.

Home Menu Editor Edit Home Menu .

Home Menu Auto 
Start

ON ON:The Home Menu is Auto Start. 
OFF:The Home Menu is not Auto Start.

Clock

Clock Type OFF
Off : No clock option of Factory menu shall work. Only Main menu.
SW Clock:SW clock shall work only.

Local Time Manual

Selection of the way to update clock data
•	 Manual: Use clock data from DVB channel or manual clock setting When the 

TV is in the stand-alone mode.
•	 Time Channel: Use clock data from the selected Channel type and Channel 

num.

Music Mode

Music Mode AV OFF

To get music output from an mp3/audio player through an AV Input Source. When 
on, you can hear sound from the player through the TV even without a Video 
signal. The TV’s backlight, however, remains on. And add a video signal,it works 
normally.

Music Mode PC OFF

To get music output from an mp3/audio player through a PC Input Source. When 
on, you can hear sound from the player through the TV even there is no video 
signal. The TV’s backlight, however, remains on.And add a video signal,it works 
normally.

Music Mode 
Backlight

OFF Backlight On/Off option in Music mode to save energy
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Hotel TV Function
Description

Category Item initial value

Remote Jack Pack

Priority AV 1
If the jack priority is set, the corresponding source is automatically set when a 
jack is inserted according to the jack priority

Priority PC 2
If the jack priority is set, the corresponding source is automatically set when a 
jack is inserted according to the jack priority.

Priority HDMI 3
If the jack priority is set, the corresponding source is automatically set when a 
jack is inserted according to the jack priority.

AV Option AV Select RJP AV Source (Source selection depends on Model).

HDMI Option HDMI 1
Select which HDMI source of the TV is connected to the RJP jack. (HDMI1/
HDMI2/HDMI3)

External Source

USB Pop-up 
Screen

Default

When USB is connected to the TV :
•	 Default : a Popup window appears.
•	 Automatic : This Enters the USB content menu automatically.
•	 Disable : Neither the popup window nor the menu appears.  

External Source 
Banner

ON

If set to On, the TV displays the External Source Banner (information) when you 
change the TV source to another external input, press the Info key, or turn the 
TV on.
•	 On : The External Source information is displayed on the TV screen.
•	 Off : The External Source information is not displayed on the TV screen.

Auto Source OFF

•	 On : When an external input source is connected to the TV, the TV identifies 
the input source, and then automatically switches to that input source.

•	 Off : Auto Source function is Off.
•	 PC : Auto Ident PC Input only.

Anynet+ Return 
Source

Power On 
Src

Select the return TV source after stopping an Anynet+(HDMI-CEC) connection. 
(This fuction is especially useful for the Guestlink RJP.)

Bathroom Speaker
Sub Amp Mode 2

Determines the Sub AMP operation mode.
•	 0: Turns the Sub AMP function off (PWM off).
•	 1: Determines the Sub volume according to the main volume control.

That is, the sub volume is determined according to the Power On Volume, the 
Min Volume, and the Max

•	 2: Determines the volume according to the bathroom control panel setting.

Sub Amp Volume 6 Sub AMP Volume level at power on initial condition.

Eco Solution Energy Saving Off

Adjusts the brightness of the TV to reduce power consumption.
•	 Off: Turns off the energy saving function.
•	 Low: Sets the TV to low energy saving mode.
•	 Medium: Sets the TV to medium energy saving mode.
•	 High: Sets the TV to high energy saving mode.

Logo/Message

Welcome Message OFF Displays a the Welcome Message for 5 seconds when the TV turns On. 

Edit Welcome 
Message

Edits the Welcome Message.

Hospitality Logo OFF
Turns the Hospitality logo feature On or Off, If On, when the TV is turned on, the 
Logo is displayed, before the signal from the initial source, for the amount of time 
set in "Logo Display Time".

Hospitality Logo 
DL

…

Downloads the Hospitality logo.
Hospitality logo file requirements:
•	 BMP or AVI files only.
•	 Max file size : BMP - 960 X 540. AVI - 30MB.
•	 The file can only be named samsung.bmp or samsung.avi.

Logo Display Time … Hospitality Logo Display Time (3/5/7 seconds).

Cloning

Clone TV to USB Clone the current TV options to a USB memory device.

Clone USB to TV Clone the saved TV options on a USB memory device to the TV.

Setting Auto 
Intialize

OFF

When Setting Auto Initialize is set to On, and the power is turned off and on or 
the Master Power is turned off and on, the data is restored to the cloned values. 
If there is no cloned value, even when the Setting Auto Initialize is set to On, it will 
be ignored and the operation will be the same as that whenSetting Auto Initialize 
is set to Off
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Hotel TV Function
Description

Category Item initial value

REACH Soulution

REACH Server 
Update Time

1hour Standby REACH Server will be operated, according to time setting

REACH Update 
Immediate

OFF Make TV operate REACH Server after 1 minute in Stand-by mode.

REACH Server 
Channel

…
Set the default channel for REACH Server
•	 None : After Auto Scan, Operate REACH Server
•	 Channel value : Operate REACH Server at the channel selected

REACH Server 
Version

0000 Display REACH Server version of TV.

REACH Server 
Group ID

All Provided REACH Server ID for operating REACH on a specific set.

REACH OFF Set whether to use REACH function.

Background TV 
Sound

ON Background TV Sound On and Off.

TICKER OFF Ticker On and Off

App Lite ... •	 On : The Applite content is  displayed.
•	 Off : The Applite content is not displayed.

Room Number 
Setting

… Set Room Number.

Network

Network Setup Connect to a wired or wireless network and access the Internet.

SmartHub Model 
Setting

Set SmartHub Model.

SmartHub Setting Set up SmartHub.

Widget Solution

Widget Mode ON Widget Mode ON/OFF.

Solution Type
Vendor 
Server

Select type of solution (Vender Server/ SINC Server).

Server URL Setting Set server URL.

License Server IP 
Setting

Set server IP.

IPTV Mode ON IPTV mode On/Off.

Virtual Standby OFF
Virtual Standby mode On/Off.
When Virtual Standby is On, TV power consumption will be 9.5W to 17.4W 
(Depending on ithe size of the TV screen).

Instant On OFF Setup booting mode.

Room Num 
Setting

Set Room Number.

System

Self Diagnosis 
for TV

…

Enter Self Diagnosis Menu.
•	 Picture Test: Use to check for picture problems. If the problem appears in the 

test picture, select Yes and follow the directions on the screen.
•	 Sound Test: Use the built-in melody sound to check for sound problems. If the 

problem occurs during the test, select Yes and follow the directions on the screen.

Self Diagnosis for 
HTV

…

HD Function Check Menu On Executing Item Below OSD is displayed ProIdiom 
DTV Channel Key Loss : Ok/Failure (Hotel US) STB SI Vendor
Setting : SI Name Ok/Failure
Bathroom AMP : Ok/Failure (Hotel EU)
RTC : Ok/Failure (Hotel EU)
PC Audio Test : Ok/Failure
PC Self Test : Ok/Failure

SW Update … SW USB Update function

Service Pattern OFF Same function with SVC Service Pattern

Sound Bar Out OFF
ON: TV speaker sound will be mute. Sound will come out through HDMI.
You must connect the Sound Bar to hear the sound.
OFF: Sound will come out through TV speakers normally.

TV reset Factory reset
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 ¦ Welcome Message

The welcome message is used to display custom messages on the TV every time TV is turned on by a Guest in Hotel room. 
 – Welcome message settings are found in the Hotel Option Menu.
 – Welcome message should be ON in order to display the message on power-on. 

Hospitality Mode Standalone Widget Solution

SI Vendor OFF System

Power On

Channel

Menu OSD

Clock

Music Mode

Remote Jack Pack

External Source

Bathroom Speaker

Eco Solution

Logo/Message

Cioning

REACH Solution

Network

r
Welcome Message ON

Edit Welcome Message

Hospitality Logo OFF

Hospitality Logo DL ...

Logo Display Time ...

 – A welcome message can be up to 25 characters and it can be edited by changing the text in the Hotel Service 
menu.

 – The following is the list of characters supported by Welcome message:
 ✎ Capital letters, from A-Z

 – Welcome message can be edited by using the navigation, colour & enter key on the Remote in the “Edit 
Welcome Message” OSD. 

 Move   Enter Return

_

 
 

Move to left

Move to Right

Leave Black

Done

A B C D E F G

H I J K L M N

O P Q R S T U

V W X Y Z

W E L C O M E

Edit Welcome Message

A

B

C

D

 – The Welcome message and hotel logo cannot both be active at the same time.

[HC690-EUROPE]Install Guide-X0ENG.indd   27 2014-04-08   �� 11:20:42



28 English

 ¦ Hotel Logo

The Hospitality Logo function displays the Hotel's picture image when the TV is initially powered on.
 – Hospitality Logo settings are the Hospitality mode menus.
 – The Logo Download and Logo Display Menu items are enabled when you turn the Hospitality Logo option on.
 – If there is a logo image stored in memory and the Hospitality Logo option is on, the Hospitality logo is displayed 

when the TV is turned on. 
 – The Hospitality logo is not displayed when the Hospitality found Logo option is off, even if the logo image has 

been loaded into the TV.

Hospitality Mode Standalone Widget Solution

SI Vendor OFF System

Power On

Channel

Menu OSD

Clock

Music Mode

Remote Jack Pack

External Source

Bathroom Speaker

Eco Solution

Logo/Message

Cioning

REACH Solution

Network

r
Welcome Message OFF

Edit Welcome Message

Hospitality Logo BMP

Hospitality Logo DL

Logo Display Time 5 Second

•	 Hospitality Logo
 – This option lets you choose whether the Hospitality Logo image is displayed or not.
 – Initial value is OFF.
 – Can be set to OFF or ON.
 – When set to ON, the Logo Download and Logo Time Display menu items become accessible.

 y Hospitality Logo DL

 – This option lets you download the logo image to the TV’s memory from a USB device.
 – A wait message appears while the image is being copied to the TV.
 – A "completed" message appears when the copy operation finishes successfully.
 – The word "failed" appears if the copy operation was unsuccessful.
 – No USB appears if no USB device is connected.
 – No File appears if there is no file to copy on the USB device or or the file is in the wrong format must be a BMP 

file. If No File appears and there is a logo file on the USB device, check the file format.

•	 Logo File Format
 – The TV supports only BMP and AVI format.
 – The file name must be samsung.bmp or samsung.avi.
 – The maximum resolution of the BMP format is 1280 x 720.
 – The maximum file size for AVI format is 50MB.
 – The TV does not change the size or scale of the image.
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 ¦ USB Cloning

USB Cloning is used to download user-configured settings (Picture, Sound, Input, Channel, Setup, and Hotel Setup) 
from one TV set and upload them to other TV sets.
All the user-defined settings from the TV (Master Set) can be copied to the USB device.

•	 Cloning from TV to USB: This copies stored data from the TV set to the USB 
device.

1. Insert a USB drive into the USB port on the rear of the TV.

2. Enter the Interactive menu by pressing buttons in order. 
•	 MUTE → 1 → 1 → 9 → ENTER

3. Press the ▲ or ▼ button to select “Clone TV to USB”, then press the ENTER button.

4. When the message “Clone TV to USB” is displayed, press the ENTER button.

5. You can verify USB cloning behavior.
•	 In Progress: during copying data to USB.
•	 Completed: copy was finished successfully.
•	 Failed: copy was not finished successfully.
•	 No USB: USB is not connected.

•	 Cloning from USB to TV: This to downloads the stored data in the USB device to TV set.

1. Insert a USB drive into the USB port on the rear of the TV.

2. Enter the Interactive menu by pressing buttons in order: MUTE → 1 → 1 → 9 → 
ENTER

3. Press the ▲ or ▼ button to select “Clone USB to TV”, then press the ENTER 
button.

4. When the message “Clone USB to TV” is displayed, then press the ENTER button.

5. You can Make sure USB cloning behavior.
•	 In Progress: copying data to TV.
•	 Completed: copy finished successfully.
•	 Failed: copy did not finish successfully.
•	 No USB: USB is not connected.
•	 No File: there is no file to copy on the USB.

 ✎ Activate copying from USB to TV by pressing ENTER key for 5 seconds.
 ✎ The Hotel TV product family does not support the CLONE function between models that supports the satellite / 
T2 operation and models that do not.

For fast, instant cloning during installation,
insert a USB drive with master settings from the first TV and press the Enter key for 5 seconds.

Logo/Message

Cloning

d
Clone TV to USB

Clone USB to TV

Setting Auto Initialize OFF

Logo/Message

Cloning

d
Clone TV to USB

Clone USB to TV

Setting Auto Initialize OFF
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 ¦ Setting Auto Initialize

When you clone settings from one TV to another, you clone both the guest side menu and hotel side menu settings: 
Picture, Sound, Input, Channel, Setup, and Hotel Setup). This lets you set nearly all of the menu values on your 
hospitality TVs to the same, standard settings. If you allow guests access to the guest side menus, for example the 
Picture menu, they can change the settings in those menus so they are no longer standard. If you set the Setting Auto 
Initialize function to on, the TV automatically restores (initializes) any guest-side menu values to the cloned, standard 
values when the TV is turned off and then turned on again. Note that Setting Auto Initialize works on cloned guest side 
menu values only. Settings which have not been cloned are ignored.

The table below lists the settings that are restored to their cloned values when you set the Setting Auto Initialize function to on.

Menu Menu Item

Picture

Picture Mode
Backlight
Contrast
Brightness
Sharpness
Colour
Tint (G/R)
Apply Picture Mode
Picture Size
   Picture Size
   Zoom/Position
   4:3 Screen Size
Auto Adjustment
PC Scrren Adjstment
   Coarse
   Fine
   Position
   Image Reset
PIP
Advanced Settings
   Dynamic Contrast
   Black Tone
   Flesh Tone
   RGB Only Mode
   Colour Space
   White Balance
   10p White Balance
   Gamma
   Expert Pattern
   Motion Lighting
Picture Options
   Colour Tone
   Digital Clean View
   MPEG Noise Filter
   HDMI Black Level
   Film Mode
   Auto Motion Plus
Picture Off
Picture Mode Memory
Reset Picture

Menu Menu Item

Sound

Sound Mode
Sound Effect
   Virtual Surround
   Dialog Clarity
   Equaliser
Speaker Settings
Additional Settings
   DTV Audio Level
   Audio Format
   Audio Delay
   Dolby Digital Comp
   Auto Volume
Reset Sound

System

Accessibility
   Audio Description
   Subtitle
   Menu Transparency
   High Contrast
   Focus Zoom
Menu Language
Smart Touch Control Settings
   Touch Sensitivity
   Onscreen Remote Size
Voice Control
   Language
   Use TV Voice
   Recognise Voice Gender
Notifications
Devie Manager
   Keybord Settings
   Mouse Settings
Time
   Clock
   Sleep Timer
   Wake-up Timer
Eco Solution
   Energy Saving
   Eco Sensor
   No Signal Power Off
   Auto Power Off
Smart Security
Auto Protection Time
Change PIN
General
   Game Mode
   BD Wise
   Sound Feedback
   Boot Loge
   Instant On
Anynet+(HDMI-CEC)
DivX® Video On Demand
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 ¦ Plug & Play

Hotel Plug & Play automatically performs Hotel mode selection, Country Setup, Clock Setup and Picture mode Setup.
 – Hotel Plug & Play is available only one time when power is first turned ON.
 – This is available after first setting up the TV and transferring Clone TV data to a USB drive.
 – To use next TV, you only need to exit Hotel Plug & Play, connect the USB, then Clone the USB to TV.
 – Depending on model and region, some menus may not exist.

Local Set

Current Localset : EU

Change Local Set if Located in North America, Latin America and Europe. 

In other regions, Please press SKIP button move to the next step.

Change Skip

Local Set

EU

Warning! TV might not function if Local Set is not correctly configured.  

When Local Set is changed, TV will turn off automatically to apply it.

Countries List

Bulgaria, Croatia, Czech, Estonia, Greece, Hungary, Latvia, Lithuania,
Romania, Serbia, Slovakia, Slovenia, EU-Others

Next

Essential Details

NextPrevious

Please Select your country
This is basic setup to use your Smart TV.

Country         Bulgaria

Picture Mode                 Standard

Easy Set Up

Intertactive

(Hotel Menu)

Standalone Setup

(Continue Setup)

Standalone Only

(End Setup)

c Next

if you select this, Easy
setup will be started.
There are Essential 
Details, Channel Scan, 
Clock and Terms in Easy 
setup.

Auto Tuning

NextPrevious Select Both to scan for both 
Terrestrial or Cable channels and 
Satellite channels.

How do you get your broadcast signal?

c Both

Satellite

Terrestrial/Cable

Auto Tuning

NextPrevious Select the connected aerial thet 
you want to use to get channels.

To receive channels, configure the options belows then
slect Scan.

Aerial            Terrestrial

Channel Type       Digital & Analogue

Scan

Auto Tuning

NextPrevious

Auto tuning is finding channels for you...

Stop

Channel     7

Digital                            0

- TV                               0
- Radio                          0
- Data/Other                  0

Analogue                        0

  2%

Auto Tuning

NextPrevious

Auto Tuning completed.

Change settings Scan Again

Digital                            0

- TV                               0
- Radio                          0
- Data/Other                  0

Analogue                        0

Select your Language

NextPress the udlr buttons 
to move the highlight.
Press the enter button to 
select. 

Select your language to start the on screen setup.

The Language Setting will be applied to Main Menu and not Plug and Play.

c English

Eesti

Suomi

Fraçais

Deutsch

Clock

NextPrevious

Set current date and timeYou can adjust your time to set DST, Time Zone and clock
mode

Clock Mode                          Auto

Date                            -- / -- / ----

Time                                     -- : --

Time Zone                            Auto

DST                                         Off -- : --

TV Setup Complete!

Previous

Your TV is now ready to use.

OK

E

E

E

E

E E

If you select Skip

If you select 
Standalone Setup

Select your language

E

E

E

E

E

If you change the country 
of the Current Location

If you select 
Change

The TV is automatically 
turned off and on
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•	 Plug & Play OSD
 – Initial Highlight: Interactive
 – If Standalone Only button is selected, Standalone hotel mode is set by default and “Standalone mode is set” 

OSD is displayed for 3 seconds.
 – TV enters into RF mode automatically after displaying “Standalone mode is set” OSD for 3 seconds.
 – When Interactive mode is selected, the Interactive Setup Menu appears. Press the power off button to exit from 

the Interactive menu.
 – When Standalone Plug & Play mode is selected, the “Select Menu Language” OSD is displayed.

•	 Select Menu Language OSD
 – When Standalone Plug & Play is selected from “Easy Set Up” OSD, “Select Menu Language” OSD is displayed.
 – Initial Highlight : English
 – Display time: OSD timeout and operation are the same as Samsung's consumer TV models.
 – If the ENTER button is pressed, “Select Area” OSD is displayed.

•	 Select Country
 – Initial Highlight: United Kingdom.
 – The Country OSD is displayed and the area can be selected.

•	 Clock setting OSD
 – Display time: 30 seconds.
 – The Clock Set item OSD is displayed
 – If ENTER button is pressed after setting the clock or in Auto, Picture Mode OSD is displayed.

•	 Auto Search Mode OSD
 – If skip option is selected, this goes to Clock setting OSD.
 – If the ENTER button is pressed, auto searching of channels is performed.
 – The OSD Display time, from the time that Auto Store is started to the time that Auto Sort is completed, is 30 

seconds.

•	 Picture Mode OSD
 – Initial Highlight: Standard.
 – The Picture Mode OSD is displayed and the Dynamic or a Standard Picture mode can be selected.
 – After selecting the picture mode and the TV enters Standalone Setup Menu OSD, press power off to exit.
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 ¦ Multi Code Remocon

Multi Code Remocon is a special transmitter which is designed to control each TV with one remote.
This is useful where there is more than one TV in a location, such as in a hospital the set ID number is displayed in the 
source osd. It is possible to support up to 9 different remote key transmissions for multiple codes.
Each TV has an inital code of "0".

 – The ID code can be set and reset in Analog TV mode or PC mode. (not available in TTX channel or DTV channel.
 – ID codecan be from 0 to 9.
 – Press the Blue Key for over 7 seconds and then select the number button to set the code.
 – Set ID OSD appears.
 – The following words appear: “Remote control code is set to x. If you want to change Remote control code. 

Enter the digit you want to change.” X is the digit number This OSD displays until Exit is pressed.

Remote control code is set to 0. If you want 
to change the Remote control code, enter the 
chosen digit.

 – For example, TV and Remote will be set to ID code #1 if the user presses #1.
 – The following words appera: “Remote control code is changed to 1” At this point, the TV can be controlled  only 

by the remote with the same ID code as the TV.
 – TV, the following words will be displayed. “ TV ID x”(x is the TV’s ID)
 – To reset the ID code, press the Yellow key for over 3 seconds. the ID code for both the TV and Remote are reset 

to “0”. “Remote control code is set to 0.” appears.
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 ¦ CH Bank Editor (Smoovie TV Only)

Channel Bank Editor edits channels, with 3 different Bank Options.
Depending on the Bank card, there are specific channels Hotel customers can enjoy.

Setting the CH Bank Editor under Stand-alone Mode

1. Enter the Hotel Standalone menu by “MUTE+1+1+9+Enter”

2. Please select SI vendor : “Smoovie”

3. find the new menu option, “Channel Bank Editor”

4. Enter the “Channel Bank Editor”

Hospitality Mode Standalone REACH Sever

SI Vendor OFF Network

d

SI Vendor Smoovie

d

Channel

d

Channel Bank Editor

<Depending on model and region, some menu items may not exist>

5. Edit the channel bank like below example.

a. BANK1 (Free channel): Select the channel that will be used when remote doesn’t have any card.

b. BANK2 (Family Card - Green): Select the channel that will be used when remote has a GREEN CARD.

c. BANK3 (Adult Card - Red): Select the channel that will be used when remote has a RED CARD.

n Move        E Select/Deselect        R Return

Channel Bank Edit

Registered Bank1 (4) Bank2 (6) Bank3 (36)

1     1futech c

2     BBC1 c c c

3     24ore.tv c c c

4     C3 c c

5     BBC World c c

6     C5 c c

7     Coming Soom c c

8     S2 c

9    S2 c

References of using SMOOVIE Remote Controller

1. If you select SMOOVIE as the SI vendor, you should use the SMOOVIE Remote Controller.

2. With the Numeric keys of the remote controller, users can select only the Bank1 channel. 
To change the channel using the Green or Red Card, please use channel up/down keys. 

3. For the Channel guide or the Channel list, users can see only Bank1 channel list.
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 ¦ Channel Editor

Channel Editor edits channel number a and name.
 – Use Channel Editor to sort the channels as user-desired channel numbers.

Hospitality Mode Standalone Widget Solution

SI Vendor OFF System

Power On

Channel

Menu OSD

Clock

Music Mode

Remote Jack Pack

External Source

Bathroom Speaker

Eco Solution

Logo/Message

Cloning

REACH Solution

Network

r Channel Editor

<Depending on model and region, some menu items may not exist>

Simple Steps for channel Editor under Stand-alone Mode

Step Broad Outline

1 Operate ‘Channel Auto Store’ in Hotel Option Menu

2 Enter ‘Channel Editor’ in Hotel Option Menu

3 Compile a table related to the final channel lists you want to have

4 Rearrange channels with the TOOLS Button based on the table you compiled 

5 Press the EXIT or RETURN Button to exit.

<please refer to the following details>

 Smoovie On sequence 

Step

Smovie TV used (Air/ Cable )

Mixed Channel Map On (Air and Cable both used) Only Air or Cable used Only Air or Cable used

If the tv starts with Hotel P&P If P&P alredy done If the tv starts with Hotel P&P If P&P alredy done

1
Do the P&P, except channel 

store
Enter Hotel menu

Do the P&P all (Air or Cable 
auto tune)

Enter Hotel menu

2 After P&P TV shows hotel menu Setup Mixed Channel Map On
After P&P TV will show hotel 

menu

Select channel type

- ATV or ADTV for Air

- CATV or CDTV for cable

3 Setup Mixed Channel Map On TV power off & on

Select channel type

- ATV or ADTV for Air

- CATV or CDTV for cable

Select smoovie TV in Hotel 
menu

4 Make TV power off & on Enter Hotel menu
Select smoovie TV in Hotel 

menu
Select Channel Setup

5 Enter Hotel menu
Select smoovie TV in Hotel 

menu
Select Channel Setup

(can be skipped)
Select "Air" or "Cable" to auto 

tune

6
Select smoovie TV in Hotel 

menu
Select Channel Setup

Select "Air" or "Cable" to auto 
tune (can be skipped)

setup CH Bank Editor

7 Select Channel Setup Select "Air + Cable" to auto tune Setup CH Bank Editor
After power off & on, user can 

use TV

8 Select "Air + Cable" to auto tune Setup CH Bank Editor
After power off & on, user can 

use TV

9 Setup CH Bank Editor
After power off & on, user can 

use TV

10
After power off & on, user can 

use TV
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Step

Smovie TV used( Satellite )

Mixed Channel Map On (Satellite and Air or Cable both usedused) Only Satellite used

If the tv starts with Hotel P&P If P&P alredy done If the tv starts with Hotel P&P If P&P alredy done

1 Do the P&P except channel store Enter Hotel menu
Do P&P all: Air or Cable auto 

tune)
Enter Hotel menu

2
After P&P TV will show hotel 

menu
Setup Mixed Channel Map On after P&P TV shows hotel menu

Select channel type

- ATV or ADTV for Air

- CATV or CDTV for cable

3 Setup Mixed Channel Map On Make TV power off & on
Select channel type 

- ATV or ADTV for Air 
- CATV or CDTV for cable

Select smoovie TV in Hotel menu

4 Make TV power off & on Enter Hotel menu Select smoovie TV in Hotel menu Select Channel Setup

5 Enter Hotel menu Select smoovie TV in Hotel menu
Select Channel Setup (can be 

skipped)
Select Satellite to auto tune

6 Select smoovie TV in Hotel menu Select Channel Setup
Select Satellite to auto tune (can 

be skipped)
Setup CH Bank Editor

7 Select Channel Setup Select Satellite to auto tune Setup CH Bank Editor
After power off & on, user can 

use TV

8 Select Satellite to auto tune Setup CH Bank Editor
After power off & on, user can 

use TV

9 Setup CH Bank Editor
After power off & on, user can 

use TV

10
After power off & on, user can 

use TV

Channel List

You can view channel information, All, TV, Radio, Data/Other, Analogue or Favourites 1-5. 
 ✎ When you press the CH LIST button on the remote control, Channel List screen displays immediately.

Channel List Guide AllShare Play Schedule Manager Source

Contents Home

R Return

* The displayed image may differ depending on the model.

•	 All: Shows all currently available channels.
•	 TV: Shows all currently available TV channels.
•	 Radio: Shows all currently available radio channels.
•	 Data/Other: Shows all currently available MHP or other channels.
•	 Analogue: Shows all currently available analogue channels.
•	 Favourites 1-5: Shows all favourite channels.

 ✎ If you want to view added favourite channels press the CH LIST button and use the L (Ch. Mode) button to 
move between Favourites 1-5.

 ✎ Using the control buttons with the Channel List.
•	 T (Tools): Displays the option menu.
•	 L (Ch. Mode / Channel): Move to the All, TV, Radio, Data/Other, Analogue or Favourites 1-5.
•	 When you select the Programme View in T (Tools) menu, you can move to other channels using L 

(Channel) button.
•	 E (Watch / Information): Watches the channel you selected. / Displays details of the selected pro-

gramme.
•	 k (Page): Move to the next or previous page.
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How to use Schedule Viewing in Channel List

(digital channels only)
When you set the Schedule Viewing in Channel List, you can only set the programme in Programme View.

1.  Press the CH LIST button, then select a desired digital channel.

2.  Press the TOOLS button, and then select Programme View. The programme list for that channel appears.

3.  Press the ▲ / ▼ buttons to select the desired programme, then press the ENTERE (Information) or INFO button.

4.  Select Schedule Viewing, then press the ENTERE button when done.
 ✎ If you want to cancel Schedule Viewing, follow steps 1 through 3. Select Cancel schedule.

Using Option Menu t
Set each channel using the Channel List menu options (Programme View, Edit Favourites, Lock/Unlock, Edit 
Channel Name, Edit Channel Number, Delete, Information, Sort, Edit Mode).
Option menu items may differ depending on the channel status.

1. Select a channel and press the TOOLS button.

2. Select a function and change its settings.
•	 Programme View: Displays the programme when a digital channel is selected.
•	 Edit Favourites: Set channels you watch frequently as favourites. Add or delete the selected channel in Favourites 

1-5.

1.  Select the Edit Favourites, then press the ENTERE button.

2.  Press the ENTERE button to select Favourites 1-5, then press the OK button.
 ✎ One favourite channel can be added to several favourites among Favourites 1-5.

•	 Lock/Unlock: Lock a channel so that the channel cannot be selected and viewed.
 ✎ This function is available only when the Channel Lock is set to On.
 ✎ The PIN input screen appears. Enter your 4-digit PIN. Change the PIN using the Change PIN option.

•	 Edit Channel Name (analogue channels only): Assign your own channel name.
•	 Edit Channel Number (digital channels only): Edit the number by pressing the number buttons.

 ✎ Some areas may not be able to support Edit Channel Name and Edit Channel Number.
•	 Delete: You can delete a channel to display the channels you want.
•	 Information: Displays details of the selected programme.
•	 Sort: Changes the list ordered by channel number or channel name.
•	 Edit Mode: Select desired channels and edit them.

Using Option Menu t
Set each channel using the menu options (Edit Favourites, Lock/Unlock, Delete, Deselect, Select All).

1.  Press the TOOLS button in Channel List screen, then select the Edit Mode. A check box appears to the left of the 
channel.

2.  Press the ▲/▼ buttons to select the desired channel, then press the ENTERE button. The (c) mark indicates the 
channel you’ve selected.

 ✎ You can select more than one channel.
 ✎ Press the ENTERE again to deselect the channel.

3.  Press the TOOLS button, then select a function and change its settings.
•	 Edit Favourites: Set the selected channels you watch frequently as favourites.

 ✎ The Edit Favourites screen has five groups (Favourites 1, Favourites 2, etc.). You can add a favourite channel 
to any one of the groups. Press the ▲/▼ buttons to select a group.

•	 Lock/Unlock: Lock a channel so that the channel cannot be selected and viewed.
 ✎ This function is available only when the Channel Lock is set to On.
 ✎ The PIN input screen appears. Enter your 4-digit PIN. Change the PIN using the Change PIN option.

•	 Delete: You can delete a channel to display the channels you want.
•	 Deselect: Deselect the selected channels.
•	 Select All: Select all the channels in the channel list.
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 ¦ My Channel

Determines the country and genre for the channels provided by the hotel, and if the user selects a country and genre, 
shows the corresponding channels.
•	 You must select the country first, or you can not set a genre.
•	 If you select the genre without adding any channels, the channel list displays all of the available channels.
•	 My Channel works in Standalone mode only.
•	 SI Vendor in Standalone mode: This does not work if Smoovie is selected.
•	 This is in the Hotel Options in Hotel Menu > Service Mode and can be turned on or off.
•	 The option only works when it is set to On.
•	 Channel Composition [Genre Mode]

Standard Category Ch. Mode
Antenna Mode Activation

Description
Air/Cable Satellite

Hotel Genre

All (Default) O O

Provide genre channel mode by each country that 
master has managed in factory mode.

News O O
Radio O O

Entertainment O O
Sport O O
Hotel O O

My Channel

Current status : Austria/Sports

Country Genre

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel
Germany

▼

(Blue)Keep Previous (U/D/L/R)Move (En)Enter

* For the number of items to be displayed in the list, refer to the design document.

Key Guide
Button Action Nav. Help

BLUE Returns to the screen. (Genre setup: Last Country & Genre) Keep Previous

ENTER Selects an item. Enter

Ch. Up/Down Move the highlight by page. (No Guide)

UP/DOWN Navigates the each country, genre list. (in a circular manner.)
Move

RIGHT Selects the highlighted item, and then move the highlight to Genre section.

RETURN Returns to the screen. (Genre setup: Last Country & Genre) (No Guide)

EXIT Returns to the screen. (Genre setup: Last Country & Genre) (No Guide)

1

8

3

6

7

2

4 5
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 ✎ Notes
•	 This section describes the layout of the Front UI that appears when the TV is turned on. (Factory Mode > Genre 

Mode: Enable)
•	 The genre is a sub-list for each country.
•	 The broadcast screen that was being displayed the last memorial channel.

 – If user want to keep the previous country & genre channel map, press the ‘BLUE’, RETURN, and EXIT remote-
control key to close the Front UI.

 ✎ Etc.
•	 Default Highlight : Last Memory items (Country, Genre)
•	 Timeout (60 sec)

Elements

No Name Description

1 Background Screen Displays the last memorized channel that appears when TV is turned on.

2 Function Title This is name of the function.

3 Current Status Display current settings the Country/Genre.

4 Country Items
The item for the country list is displayed.

Displays the last selected country.

5 Genre Items

The item for the genre list is displayed.

Displays available genre items by each country that master managed in factory mode. (always 
provide ‘All’ item)

Displays the last selected genre.

6 Highlight If the item title is too long to be displayed within the area, Auto Text Sliding works.

7 Indicator This is displayed when there is a previous or next page.

8 Nav. Help The key guide is right-aligned.
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Highlight Interaction [Country Items]

•	 This page is only to indicate possible interactions. It may not be exactly identical to actual screens.

 ✎ Notes
•	 Users can navigate the items in each country & genre list by pressing the up or down remote control keys.
•	 Circular navigation is supported.

DOWN x 4 

DOWN x 4

DOWN x N

DOWNDOWN

UP x 4

UP x 4

UP x N

UPUP

END

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

1 My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

Austria All

Belgium (Dutch) News

Belgium (French) Radio

Czech Entertainment

France Sports

Germany Hotel

Hungary

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

Slovakia All

Spain News

Switzerland Radio

United Kingdom Entertainment

Eastern Europe Sports

Other Hotel

▼

My Channel

Current status : All Country/Sports

Country Genre

▲

Slovakia All

Spain News

Switzerland Radio

United Kingdom Entertainment

Eastern Europe Sports

Other Hotel

▼
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Highlight Interaction [Default Genre]

•	 This page is only to indicate possible interactions. It may not be exactly identical to actual screens.

•	 The current selection of the country is high-lighted. •	 Default High-light: The current selection of the genre.

•	 Seems source error, it should be read as "The other 
item of the county is high-lighted.". Please verify. (ex. 
France)

•	 Default Highlight : All

ENTER / RIGHT

LEFT

ENTER / RIGHT

LEFT

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

[HC690-EUROPE]Install Guide-X0ENG.indd   41 2014-04-08   �� 11:20:46



42 English

Mode Change Interaction 1 (1/2)
•	 This page is only to indicate possible interactions. It may not be exactly identical to actual screens.

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

DOWN

LEFT

•	 Current Genre Mode : All Country / Sports

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

DOWN

UP

ENTER

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

•	 If the country is selected, highlight moves to genre menu 
automatically.

ENTER / RIGHT

ENTER / RIGHT

6
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Mode Change Interaction 1 (2/2)
•	 This page is only to indicate possible interactions. It may not be exactly identical to actual screens.

5 6

•	 The genre mode change complete message is displayed.
•	 Timeout(5 sec.)

•	 Pressing the left key from the genre to country menu highlights 
an existing selected country item.

ENTER / RETURN / Timeout

Current Status : Austria / News

1

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

ENTER
1

Info Genre Mode change to Austria/News.

OK
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Mode Change Interaction 2 (1/2)
•	 This page is only to indicate possible interactions. It may not be exactly identical to actual screens.

1

DOWN

UP x 5

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

•	 Current Genre Mode : All Country / Sports

•	 If the country is selected, highlight moves to genre menu auto-
matically.

•	 Current Genre Mode : All Country / Sports

ENTER / RIGHT

Current Status : Austria / News

BLUE
/

RETURN
/

EXIT

ENTER 
/ 

RETURN
/

Timeout5

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area

101

Info Genre Mode change to Austria/News.

OK
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Power On Scenario [Last Memory]
•	 This page is only to indicate possible interactions. It may not be exactly identical to actual screens.

1

•	 Current Genre Mode : Austria / News

•	 Current Genre Mode : Austria / News

Current Status : Austria / News Power Off
POWER

POWER

My Channel

Current status : All Country/Sports

Country Genre

▲
All Country All

Austria News

Belgium (Dutch) Radio

Belgium (French) Entertainment

Czech Sports

France Hotel

Germany

▼

Navigation Help Area
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Genre Editor: This configures the genres of each of the hotel TV channels.
•	 This can be used through the Hotel Menu (Factory).
•	 Supported genres include News, Radio, Entertainment, Sports and Hotel.
•	 More than one genre can be selected for each channel at the same time. 

Country Editor (Channel Editor): This is the editor that configures the country for each of the hotel TV channels.
•	 Supported countries (20 countries): Austria, Belgium, China, Denmark, Finland, France, Germany, Greece, Italy, 

Japan, Netherlands, Norway, Portugal, Russia, Korea, Spain, Sweden, Turkey, USA 
•	 If more than one channel is set to a country, the country is registered as a category and users can view the channels 

by country.
•	 More than one country can be set to a channel. If the user selects a category, only the channels corresponding to the 

country are displayed in the channel list.
•	 If any channel for which the country is set is selected from the channel list, the Edit Countries item is added to the 

Tools. Otherwise, the Add to Countries item is added to the Tools.
•	 * If the corresponding function is executed, a country for the selected channel can be set or canceled.
•	 Front UI
•	 Provides the screen where the user can select a country or genre when the user turns the power on.

Left Frame Layout

Key Guide

Button Action Nav. Help

ENTER Selects or enters the corresponding Channel Browser area. (No Guide)

RETURN Selects or enters the corresponding Channel Browser area. Return

UP/DOWN Moves the highlight up or down. (No Guide)

RIGHT Moves the highlight to the Channel Browser area. (No Guide)

INFO Shows the Category Info. (No Guide)

TOOLS Shows the utility function menus. Tools

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes
•	  This is a component of the Left Frame (Country Categories).

 ✎ Etc.

•	 Default Highlight: ‘The currently selected country’
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Elements

No Name Description

1

•	 When the user enters this screen, the currently selected default item is highlighted.
•	 The Country Icon + Category Name are provided. (If the highlight is in the Main Frame, only the 

icon is displayed.)
•	 Moving the highlight

 – Pressing the up or down button moves the highlight.
 – If the items cannot be displayed on one page, up and down indicators are provided.
 – Once the highlight is moved to a category, the channel list corresponding to the 

corresponding category is loaded to the Main Frame.

Left Frame [Country Categories]

Standard Category Ch. Mode
Antenna Mode Activation

Description
Air/Cable Satellite

Hotel

Original Tuned Registered O O
•	 Lists all the channels registered by the Auto 

Tune operation.

Country All Country O O
•	 Provides the list of channels and sources 

specified in the Registered Channels list.
•	 All Country is the sum of all channels regis-

tered to each country. (This is only provided 
to end users.)

Country 1 O O

Country 2 O O

. O O

Tools [Registered/Countries Categories]

•	 •	Channel	Manager	>	Channel	Category	>	Tools	>	Info

•	 The items are displayed without ‘Channel’.
•	 If the Registered/Country item in the Left Frame is 

highlighted, you can enable the corresponding window 
by pressing the ‘INFO’ remote control key.

•	 All countries are displayed.
•	 navigate country items by pressing the up or down key. 

Indicators are provided.
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 ✎ Notes
•	 This is a definition of the Tools menu in the Left Frame Category.
•	 Only the Info item for each Register/Country is provided.

Elements

Category Tools menu Descriptions

Registered, Country Information Registered Channels. The number of channels of each country.

•	 •	The	items	are	displayed	without	‘Channel’.

Error Cases

 ✎ Notes
•	 This is the message for when there are no saved channels in the Registered Channels list.

Elements

No Name Description

1 Message

•	 When entering the browser, if the Registered channels item is empty, 
a popup message is displayed which enables users to switch to the 
Auto Store (Program) menu.

•	 When both the time and the channel are not configured, and a user 
enters the Channel Manager, a message that allows the user to 
switch to the Auto Tuning (Auto Program) operation is displayed in 
the same way as above.

•	 This is the message when the time is not configured.
 – If the time is not configured, the message is displayed in Factory Mode before entering the Channel Manager.
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 ✎ Notes
•	 This is the component for when there are no channels registered to the country category.

Elements

No Description Description

The message is displayed when the currently selected country does not contain any items.

Main Frame [Channel Browser]

[HC690-EUROPE]Install Guide-X0ENG.indd   49 2014-04-08   �� 11:20:51



50 English

Key Guide

Button Action Nav. Help

CH UP/DOWN Moves the page. Page

ENTER Selects or enters the corresponding Channel Browser area. Select

RETURN Returns to the previous step (Factory Mode). Return

UP/DOWN Moves the highlight up or down. (No Guide)

RIGHT Moves the highlight to the Channel Browser area. (No Guide)

INFO Shows the Category Info. (No Guide)

TOOLS Shows the utility function menus. Tools

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes
•	 This is a component of the Main Frame (Channel Browser).
•	 The initial highlight is on the channel before entering Factory Mode or the external input.

Elements

No Name Description

1 Main Frame •	 Shows the channel or the source list of the currently selected category.

2 Scroll Bar •	 Shows the position of the current page amongst the total amount of pages.

3 Navigation Help Area
•	 This is displayed whenever a user enters the Channel Manager. (If a user exits and 

then reenters the Channel Manager, it is displayed again.)
•	 This disappears when the timeout (5 sec.) is reached or a user presses a key.

4 Navigation Help Area
•	 The currently configured country information and the RED buttons are left-aligned. 

They are displayed and navigated by group graphically. The key guide is right-aligned.
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Channel Common Elements [+ Icon-method]
Channel list representation rules

Standard Item Construction

ATSC

Digital channels
•	 Check Box + Status Icon + Digital Channel Number + Channel Name
•	 Channel number representation format: ###-### (The channel number is 

represented by ‘-’.)

Analog channels
•	 Check Box + Analog Icon + Analog Channel Number + Channel Name
•	 Channel number representation format: ### (‘-’ is not used to represent analog 

channel numbers.)

DVB (CHEM)

Digital channels
•	 Check Box + Status Icon + Digital Channel Number + Channel Name
•	 Channel number representation format: ### (For the maximum length of the 

channel number, follow the regional specifications.)

Analog channels
•	 Check Box + Analog Icon + Analog Channel Number + Channel Name
•	 Channel number representation format: ### (For the maximum length of the 

channel number, follow the regional specifications.)

Channel list icon representation rules

Item Example Priority

Dynamic SI

Icon

Channels deleted by 
Dynamic SI  NNNNNNNN CH. NAME

•	 Channels that have been deleted by the Dynamic 
SI but not by the user.

1

Channels added by 
Dynamic SI  NNNNNNNN CH. NAME

•	 Channels that have been added by the Dynamic 
SI but not by the user.

2

Analog Channel Icon
 NNNNNNNN CH. NAME (The 

edited channel name.)
•	 The analog channel icon is displayed. 3

Source Channel Icon
 NNNNNNNN CH. NAME •	 A channel that is an input source. 4

Antenna Icon Air
 NNNNNNNN CH. NAME

•	 Represents the live channels from the anten-
nas. The Air, Cable or Satellite antenna icons are 
displayed with the lowest priority.

5Cable
 NNNNNNNN CH. NAME

Satellite
 NNNNNNNN CH. NAME

Scrambled Channel Icon NNNNNNNN CH. NAME 
•	 The scrambled channel icon. This appears for the 

Satellite antenna.
-

Video Mute NNNNNNNN CH. NAME 
•	 A screen-muted channel. Audio and channel 

information is provided.
-
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Add to Countries / Edit Countries (1/2)

Key Guide

Button Action Nav. Help

ENTER Selects the highlighted item. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

UP/DOWN Moves the highlight over country items. Move

LEFT/RIGHT Moves the highlight. Move

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Note
•	 This is the definition of Add to Countries. 
•	 The highlighted channel or more than one selected channel is added to the Country category.

 ✎ Etc.
•	 Timeout (60 sec)

•	 Channel Manager > Browser > Tools > Add to Countries
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Elements

No Name Description

1
Add to Countries

Window

•	 If there are no channels that have been registered to the country list in 
the selected channels, “Add to Countries” is displayed as the title.

•	 A check box is displayed depending on whether the country that was 
selected when entering the screen is registered or not.

2 Guide

3 Selection Info

•	 The number of the selected channel or the channel name.
- The channel name is displayed when one channel has been 
selected: Selected channel: NNNN-NNN ABC

- The number of selected channels is displayed when more than one 
channel has been selected: Selected Channels : N

4 Complete Message
•	The	message	is	displayed	after	the	completion	of	the	operation.	(This	
message is always displayed if the OK button is selected.)

5 Selection Mark

•	How	to	identify	the	meaning	of	multiple	channel	selection	marks

	•	When	all	of	the	items	have	been	registered.

	•	When	only	part	of	the	items	have	been	registered.

	•	When	none	of	the	items	have	been	registered.

Add to Countries / Edit Countries (2/2)

Key Guide

Button Action Nav. Help

ENTER Selects the highlighted item. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

UP/DOWN Moves the highlight over country items. Move

LEFT/RIGHT Moves the highlight. Move

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

•	 Channel Manager > Browser > Tools > Add to Countries
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 ✎ Notes
•	 This is the definition for Edit Countries. 
•	 The highlighted channel item or more than one selected channel item is added or deleted from the Country 

category.
•	 Timeout (60 sec)

Elements

No Name Description

1 Add to Countries

•	 If there is a registered channel among the selected channels, Edit Coun-
tries is displayed as the title.

•	 A check box is displayed depending on whether the selected country is 
registered or not.

2 Guide

3 Complete Message
•	 The message is displayed after the completion of the operation. (This 

message is always displayed if the OK button is selected.)

Edit Channel Number [Swap Type]

•	 Channel Manager > Browser > Tools > Edit Channel Number

Key Guide

Button Action Nav. Help

ENTER Applies the changes and closes the window. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

U/D Changes the channel number of the selected channel. Adjust

0~9 Enters a digit. Number

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes
•	 This is the function that changes the channel number. (Swap Type)
•	 Channel numbers can be changed in all the channel lists and changes are applied to all the channels.
•	 If the new channel number has not been allocated to another channel, the channel number is updated to the new 

channel number and the list is sorted again in ascending order of channel number.
•	 If the new channel number has already been allocated to another channel, follow the Hotel specifications.

 ✎ Etc. Vertical circulation is supported.

[HC690-EUROPE]Install Guide-X0ENG.indd   54 2014-04-08   �� 11:20:53



55English

Elements

No Name Description

1
Edit Channel

Number Window

•	 Both the numeric keys and the Up/Down keys are supported.
 – Selected Channel: Shows the currently selected channel name.
 – Number: Shows the new channel number.  

(The currently allocated channel name is also displayed.)

 – Name: Shows the currently allocated channel name. (If there are no 
channels, it is displayed as “(Empty)”.) : If there is a channel but it 
does not have a name, the name is represented as “-----”.

2
Warning

Message

•	 If an already allocated channel is selected
 – If the new channel number has already been allocated to another 

channel, the confirmation message pops up. (Refer to the figure 
below.)

 – If the user wants to change the channel number to one that has 
already been allocated to another channel, the channel numbers are 
swapped and saved.

Edit the Channel Number [External Input] (3/3)

•	 Channel Manager > Browser > Tools > Edit Channel Number
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Key Guide

Button Action Nav. Help

RED If a user presses the button, the channel number is initialized. Reset

ENTER Applies the changes and closes the window. Enter

RETURN Cancels or returns to the previous screen (Tools). Return

U/D Changes the channel number of the selected channel. Adjust

0~9T Enters a digit. Number

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes
•	 This function allocates an external input source to a channel number. (The changes are applied to all the 

channels.)
•	 If the new channel number has already been allocated to another channel, follow the Hotel specifications.

 ✎ Etc.
•	 Default Highlight: Channel number area.
•	 Vertical circulation is supported.
•	 Timeout (60 sec)

Elements

No Name Description

1 Channel Number Area

•	 The channel number area.
 – Both the numeric keys and the Up/Down keys are supported.
 – If no value is allocated, as many ‘-’ are displayed as the number of digits.

▲ ▲ ▲

-- → 1 → 15

▼ ▼ ▼

2 Source Name
•	 External input name

 – Items that cannot be configured are disabled.

3 Nav. Help Area •	 If a user presses the red button, the channel number is initialized.
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Edit Channel Name

•	 Channel Manager > Browser > Tools > Edit Channel Name

Key Guide

Button Action Nav. Help

GREEN Saves the changes and returns to the Channel Manager. Done

ENTER Saves the channel name and moves the cursor to the next field. Enter

RETURN Cancels and returns to the previous screen (Tools). Return

U/D/L/R Navigates on the keyboard. Move

0~9 Enters a digit. (No Guide)

INFO N/R N/R

TOOLS Closes the current window and displays the ‘Tools’ menu. (No Guide)

EXIT Cancels and returns to the previous step (Factory Mode). (No Guide)

 ✎ Notes
•	 This is the definition of the keypad that is used for the Edit Channel Name function.

 ✎ Etc.
•	 Timeout (60 sec)

Elements

No Name Description

1 Channel Name Edit Window

2 Channel Name
•	 The cursor and the character that are currently being entered are in the same colour as 

the highlight.
•	 When the maximum number of characters is reached, the cursor disappears.

3 Keyboard •	 For a detailed scenario, refer to the keypad design document.
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Tools [Edit Mode]

Edit Mode

Content Highlight (when the number of the checked item is 0 or 1) When there is more than one checked item.

Add to Countries

Edit Countries (when an already-registered item is checked.)

Channel Name Edit

Edit Channel Number

Video Mute

Channel Copy (Astra HD +)

Reorder (Satellite)

Select All

Deselect All (this is only displayed when 1 or more items are 
selected)

Delete

Add to Countries

Edit Countries (when an already-registered item is checked.)

Video Mute

Reorder (Satellite)

Select All

Deselect All

Delete

 ✎ Notes
•	 The position of the popup menu: The Tools menu for an item in the left column of the Channel List → This is 

displayed on the right. The Tools menu for an item in the right column of the Channel List → This is displayed on 
the left.

•	 If a user presses the Tools button when the highlighted item is not selected, the item is automatically marked as 
selected.

•	 For detailed specifications of each function, refer to the NEO Channel Manager.
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CH Banner [when a channel number is allocated to an external input]

 ✎ Notes
•	 The TV channel banner specifications are applied.
•	 When there is an unsupported item or there is no corresponding information, the item values are not displayed.
•	 The channel name is represented as the ‘external input name’.

Elements

No Name Description

1 External Input Name

The Channel List provides access to functions related to GenreTV.
•	 Country Mode
•	 Changes the genre mode.

 ¦ Mixed Channel Map

Mixed Channel Map is a function to mix Air, Cable and Setellite channels.
[ Except for Aus, Singapore, NZ models ]

 – Mixed channel Map should be ON in order to mix Air, Cable and Setellite channels.
 – Use Channel Editor to sort the channels after turning on  'Mixed channel Map' in Hotel Option Menu.
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 ¦ Sound Bar

•	 Samsung Sound-Bar & Hospitality TV
 – Use Samsung Sound-Bar & hospitality TV support HDMI 1.4 to listen to TV sound on the Sound-Bar by using a 

single HDMI cable.
 – Supporting model.

•	 Sound-Bar : HW-F350/F450/F550

•	 Operation of “Hotel Mode” in Sound Bar

 – The following items for the TV’s hotel option menus should be set in advance.
•	 Hotel option → Power On → Power ON Volume = "Enable" / Power ON Vol / Max Vol
•	 Hotel option → External Device → Sound Bar Out = "On"
•	 Connect an HDMI cable from the HDMI OUT port of Sound-BAR to the HDMI2 port of hospitality TV.
•	 After being connected to the 2013 hospitality TV via HDMI Cable, when the TV turns on, the Sound-Bar 

automatically detects the TV and then, converts to “hotel mode” by itself.
•	 The change with power-on volume & max volume on TV is applied to the connected sound-bar since TV 

boots twice.
•	 Features of "Hotel Mode" in Sound Bar

 – Synchronized power on/off with TV.
 – HDMI_CEC enabled.
 – Accessible “HDMI OUT” port only. (Other inputs are disabled)
 – Synchronizing “power-on”&“max” volume with the TV the Sound-Bar’s volume is set at half of the TV.
 – Adjustable “power-on”&“max” volume acquired from the TV’s hotel option menu. Sound-Bar volume=TV 

volume/2
 – Example: If the volume settings in TV are “power-on volume=20 and max volume=90”, the sound bar will 

operates at volume=10, max volume=45.

*This function may differ depending on the model.

 ¦ Security mode

Design Specifications

•	 This is to restrict some functions such as TTX and external source (HDMI, USB) input in specific facilities such as 
a correctional facility.

•	 The Security menu is password-protected. Access to the Security menu is denied without the password.
•	 Security Setting

 – The Security Setting can be set to ONor OFF.

 – The default is OFF. 

 – Security Setting: If set to On, external source (HDMI, USB) input and the TTX function will be disabled.
•	 Password Setting

 – This allows users to change the password. 

 – Users must input the current password, a new password, and confirmation of the new password.
•	 Password Reset

 – This is to reset the password.

 – The default password is "00000000".

 – Password Reset is visible only in the Factory menu by using the key combination of Info and Factory. 
It is not visible using the key combination of MUTE + 1 + 1 + 9 + ENTER.

•	 Security Setting: If set to On, the SIRCH function is not available.
•	 Factory Reset will not reset the Security Setting.
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SIRCH

•	 Introduction
SIRCH (Samsung Interactive Remote Control for Hospitality) is a professional interactive remote controller for DTV 
that lets you deliver TV firmware updates, cloning data, and channel mapping changes to several hundred hospitality 
TVs simultaneously. Mounted at the broadcast head-end system in hotels, motels, resorts, hospitals, and apartment 
buildings, it delivers modulated RF control signals to hospitality sets in each guest room through coax cable. 
SIRCH includes PC embedded sy+stems and cable RF modulators which have DVB-C (Europe) and OpenCable 
(North America) RF output. It also has a 40GB Solid State hard drive, and a 100/1000 Base-T Ethernet port which 
lets you load TV firmware updates. 

 ✎ SIRCH is sold separately.

•	  System Block Diagram (eg. Headend System in Hotel)

SIRCH

Headend System for Hotel

HD ENCODULATOR

HD ENCODULATOR

HD ENCODULATOR

HD ENCODULATOR

Satellite Receiver

Independence AV Stream

Cable STB

Terrestrial Receiver R
F 

C
om

bi
ne

r

•	 Features
 – SIRCH Windows Application SW
 – 19 inch Rack Unit type, PC embedded Modulator : OpenCable.
 – Remote Upgrade (TV Software, Cloning Data, Channel Map)
 – Operation can be controlled by key button, extra key board, monitor, and mouse.
 – Low Phase noise, High MER, 50~870MHz, +7 ~ -30dBm RF output.

•	 Cautions
 – SIRCH can operate only in TV RF mode. (OpenCable QAM Modulation).
 – You can install SIRCH only on TVs in stand-alone mode. Power On Source should be TV.
 – SIRCH operates only when the SIRCH application version is higher than the TV’s SIRCH version.
 – You must check the SIRCH application version to ensure it is compatible with the TV firmware version.
 – The SIRCH function is not supported for satellite channels. 

(To use the SIRCH function in satellite models, make sure to set the Power On Channel to an Air or Cable 
channel.)
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•	 SIRCH operating Diagram

Coax.

Cable
RFTCP/IP

(Windows 
Remote 
Access)

Hotel Installer can edit the Install Menu/
Channel Map data using the SIRCH 
windows application program.

You can updated all hospitality TVs in an 
entire installation.

This includes delivering TV firmware, 
channel mapping, and settings.

•	 SIRCH Installation Considerations
There are a number of factors and operations you need to consider when you set up and run SIRCH:

1. Set the SIRCH Update Time
 – Under normal conditions, use Standby SIRCH. Standby SIRCH updates TVs when they have been in Standby mode for a 

certain length of time or when they are in Standby mode at a certain time every day.
 – You can set the standby SIRCH value  to Off, 1Hour, 2Hour, 12:00 PM, 02:00 PM, 12:00 AM, or 02:00 AM.
 – The default value is 1Hour.
 – When you select “1Hour” or ”2Hour”, 1 or 2 hours after a TV goes into Standby mode, the SIRCH upgrade starts 

automatically.
 – If you select a specific time setting, the Standby SIRCH is performed once a day at the defined time.

2. Set the SIRCH Channel
 – Use SIRCH Channel to set the PID frequency that willl carry the SIRCH parameters to the TVs in the system.
 – Open Cable : You can use CH2 through CH135.
 – A detailed frequency table is available in the SIRCH Windows Application Program User's Manual.

3. Verify the SIRCH Version
 – The SIRCH version at the headend must be a higher version than the version on the TVs for the TVs to update.
 – For example, if the software version in the SIRCH PC application is 01a0, then the current TV SIRCH version on a TV must be 

less than this for the TV to update. 
 – The software version value updates to a higher value automatically each time a change is implemented.
 – The software version value for the TV clone data must be in hexadecimal format.

4. Test using Manual SIRCH 
 – Plan to use Manual SIRCH to test whether SIRCH has been installed properly.

 ✎ NOTE
•	 Please visit www.lumantek.com/sirch/ for more information.
•	 SIRCH Windows Application Program User's Manual is available at http://www.samsung.com/us/business/

hospitality.
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 ¦ GENERAL INFORMATION

•	 System Overview
The ‘Samsung Interactive Remote Control for Hospitality (SIRCH)’ application is a Remote Control Update system 
designed to provide better and more cost-effective service for Hospitality industries. This allows user/operators to 
configure the guest TV with RF distributing system. Using this helps the user to set and configure the guest room TV 
Set parameters. The created setting file will get used by SRCUS for configuration of guest TVs.
The Application is intended to create or modify clone files for user and to update guest TV with these clone files by 
transmitting them via RF. Using this provides a user interface similar in appearance to the TV’s parameter settings 
where user the can update factory menu settings and modify or tune channels to update guest TVs.
To effectively complete and support the requirements of the “Hospitality” Industry, a management system is needed 
that will allow the operator to have control of the TV sets in the guest’s room without requiring a potentially disruptive 
or costly visit to each room

 – Channel Configuration Made Easy All from the Head End FMA System.
 – Will configure and deliver the channel line-up and SW upgrade to the guest room terminals via the 

hotel’s coaxial distribution.
This application is an S/W utility to configure user configuration parameter defined below:

 – Hotel Factory Menu (Standalone Menu/Interactive Menu)
 – Channel map

This also supports generation of a TS stream embedding clone file information and control of the modulator used for 
broadcast of the TS stream.

•	 Purpose of the Document 
This document is prepared to facilitate and guide the user in creating/modifying clone files, to update interactive/
standalone menu settings, to configure channel map and to create TS stream using SIRCH. Screens-wise 
explanations are provided here for the process flow.
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 ¦ GETTING STARTED

•	 Installation instructions for Windows XP/Vista/2007

1. To install Samsung Interactive Remote Control for Hospitality (SIRCH), 
locate and open the setup directory of SIRCH and double-click on the 
file “setup.exe”. 

2. Click on Next Button to proceed for Installation wizard of SIRCH.

3. Read the license agreement carefully and select “I accept the terms in 
the license agreement” and click on Next button.

4. Please enter User and Organization information and click on Next to 
proceed.

5. Click Next to install the application files to the default folder, or click 
Change to install to a different folder.
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6. Choose the setup type (Complete / Custom) that best suits your needs. 
Complete is recommended for users as it will install all program features.

7. The wizard is ready to begin installation. Click on Install to begin the 
installation.

8. After installation process completes, Click Finish to exit the wizard.

9. After clicking on finish a desktop icon is made for launching SIRCH 
application and also it is added in your Start Menu → Programs.

•	 Launching/Starting SIRCH Application

1. To launch SIRCH, either user can double-click on the icon made 
on desktop named “SIRCH.exe” or user can go to Start Menu → 
Programs → Samsung → SIRCH → SIRCH.exe.

2. Application will launch a window asking to select Mode and 
Model to proceed.

3. User can choose options form File Menu to proceed to his 
specific application requirement.

•	 Uninstalling SIRCH Application

1. To uninstall SIRCH go to StartMenu → Programs → Samsung → SIRCH → Uninstall.exe.

2. Follow the steps of uninstall wizard.
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•	 Create New Clone Files
After launching SIRCH, the application shows a window asking for Model and Mode selection. The application starts 
with the utility to create new clone files thus other utilities can be called from File Menu. To create new files user may 
follow the following steps:

1. To create new file, either launch SIRCH.exe or choose Create 
New File from File Menu.

2. Select the series, region, LCD/LED type of the model from the 
drop down boxes.  
If the user doesn’t know the series,region or type of the model, 
select “All”.

3. Selecting Region, Series and type will filter out the Models in 
Modelno. Dropdown box.

4. Select TV Model from the drop down box in front of “Model” 
Option.

5. After selecting Model no. S/w name of the model will shown in S/W name box.

6. Click the Proceed button.

Select Model’s 
Series, Region, 
LCD/LED 

Select TV Model 
Software Name for 
selected TV Model 
appears
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•	 Modify existing Clone files
To modify the existing clone files, the user must follow these steps:

1. Go to File Menu → Load from file. If the option is disabled 
user is probably on the next screen so he must come back to 
main screen by clicking back button.

2. After clicking on Load from file, a browser window opens 
asking the user to locate the clone file folder. The user must 
locate the immediate parent folder of the files not the folder 
named with version no.

3. After locating files click on OK. 

4. Model no, Region, Series, Type and S/W name will be 
uploaded from clone files and are visible to the user. The user 
is not allowed to change them.

5. Click the Proceed button.

6. All Hospitality option menu settings and channels in the 
channel map are loaded from the files. Users can change 
them and can save them or overwrite them.
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•	 Hospitality Options Setting
After clicking Proceed the application navigates users to another screen with different tabs: next screen with different 
tabs Hospitality Options, channel map and generate navigating to other Tabs does not lead to any  loss of unsaved 
data. 
To modify factory menu settings-users may follow these steps:

1. Select the Hospitality Options Tab.

2. The application shows Blue labels and drop down boxes in 
front of each labels which have their different values.

3. The user may select any value from the drop down box to 
change its parameters.

4. Default values selected are shown according to that particular 
TV Model’s default settings, if the user doesn’t make changes.

5. Dark and Dim labels cannot change and are disabled.

6. To set logo user can click on logo Download which will 
navigate him to a file browser window.

7. User should Click save button only when all settings are done, including Channel Map settings, because the 
save button generates Clone files.

Hospitality Option 
TAB

Disabled 
Parameters

Drop Down Box 
to change default 

values  
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•	 Channel Map Configuration
The Channel Map tab shows a list of channels in a table with every channel, channel name, PTC no., Program No., 
Modulation and Program Type shown. Channel map information is only configured for English. Channel names in 
any other language, in a clone file loaded from a TV, will remain undisturbed after changes resulting from the SIRCH 
application. The channel category is a list of options for Air, Cable, Satellite at the left of the table. All is selected as 
default, which shows every channel. By selecting Analog or Digital users can filter the channel list. Users can add 
new channels, edit existing channels or delete them by clicking the add, edit and delete buttons. Edit also shows 
complete information for a channel, information that can be modified by the user.

•	 Add a New Channel
To add a new channel, user must follow these steps:

1. Select Air, Cable or Satellite to add a channel.

2. Select Analog or Digital.

3. Click the Add button. Application will pop up an Add New Channel 
Window.

4. Fill and complete the information fields. The information required varies 
by region.

5. Click Add to add the channel, or click Cancel.
(For DTV channels in ATSC models, the display number has two fields: 
and minior. These can be set to any values, from 0 to 999.)

All is selected as default.

This filters the channels 
according to their type: 

Air, Cable or Satellite.
Buttons to Add, Edit and 
Delete Channels  

Channel List    

Analog/Digital Radio 
selection will further 

filters channels in the list 
according to their type.
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•	 Modifying an existing Channel from the list
To modify parameters for an existing channel , including PTC number, program type, etc., follow these steps:

1. Select Air, Cable or Satellite.

2. Select Analog or Digital.

3. Select the channel from the list to Modify and click on Modify button.

4. Modify the respective fields.

5. Click Edit to modify the channel , or click Cancel
(For DTV channels in ATSC models, the display number has two fields: and 
minior. These can be set to any values, from 0 to 999.)

•	 Deleting a Channel from the list
To delete an existing channel from the list user must follow the following steps:

1. Select Air, Cable or Satellite.

2. Select Analog or Digital.

3. Select a channel from the list click Delete.

•	 Channel - Editor
To change display no. or channel name, users must follow these steps:

1. Select Air, Cable or Satellite.

2. Select Analog or Digital.

3. Select the channel from the list to Edit and click Channel-
Edit.

4. Change the display number. or the name of the channel. 
Click OK to edit the channel.

5. If a new display number. already exits, the application asks 
users to modify the display number.
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•	 Saving Clone Files
To save the clone files with modified parameters and channel map configuration, user must follow these steps:

1. When finished changing data on the Interactive/Standalone 
menu and one the Channel map, click Save.

2. A browser window open, asking for the location to save the 
data. Select a folder where the files should be saved or 
create a new one. location to save the clone files.

3. After clicking Ok, files are saved in a folder named by the 
version no. of the model. User can find clone files inside 
(Location given by user) → (Model version number) → Clone.

•	 Going Back to Main Screen

1. To go back to the main screen, click Back. This operation will 
not save parameter changes or the channel map configuration, so be sure to save clone files before going back and 
select a different model.

•	 Merging with TS- Stream
To merge clone files with the TS-stream follow these steps:

1. Go to File Menu → Utility → Generate and click on Launch 
TS-Merge.

2. Please read about Update version clauses [2.13] before 
merging.

3. Select Merge Clone files to clone files.

4. Browse the Clone files folder.

5. Browse the seed stream folder. 

6. Click the generate button to generate the stream An output 
stream will be generated. It takes a few minutes to create the 
output stream.
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•	 Launching Ventus application
Go to File Menu → Utility → Generate and click GO for Launch Ventus

•	 Upgrading the clone or binary file on TV
To upgrade the clone for binary file on the TV, use a prepared merged stream (Binary_outputstream.mpg or clone_
outputstream.mpg).

1. Locate the stream file in the Modulator utility ( as explained in 2.11).

2. Set the set channel to broadcast the stream by clicking on Frequency Table.

3. Select Opencable for ATSC or DVB-C for DVB models.

4. Click Play to broadcast the stream.

5. In TV’s factory menu, the SIRCH channel must be same as the channel on which stream is broadcasting.

6. The SIRCH version must be earlier than the software version set before generating the stream file.

7. Click on Manual SIRCH. Please check taht the channel setup is set to Cable, not Air, if the cable is connected 
to TV for broadcasting.

•	 Updating the application with new Model
To update the application with a new model, to configure the clone files for that model, users must possess a model 
installation XML file. To update a new mode, follow these steps:

1. Go to File Menu → Update New Model.

2. A window (Add/Update Model) opens and asks users to enter 
the Configuration file (Model installation xml file). Click the 
Browse button to locate the model installation xml file.

3. After selecting the installation file, the window shows the model 
name, series, region and TV model name in extboxes.

4. To add model click the Add button. If a model already exists, 
application will update the model orl add the model in the 
model dropdown box.

5. To close the window click Close button.
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•	 Update SIRCH Version 
To update the SIRCH version for Clone and user should follows as below.

1. Go to File Menu → Update Software Version.

2. A window opens asking for the Software Version (Clone File Up gradation).

3. User should provide a higher version than the TV's current version in version value. E.g.  

i) If software version is set as 01a0 in SIRCH PC application, then current TV SIRCH version should be less 
than this value for update. 

4. Software version value for clone should in hexadecimal format e.g. fa1b but less than ffff. 

5. After providing the value, click on Update update version value.

•	 Closing the application 

1. To close the application, either click the close button on the top right or go File Menu and Exit.
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•	 FAQs 
If SIRCH has a problem, first review this list of possible problems and solutions.

•	 Test SIRCH modulator controller settings:

 – The SIRCH upgrade only supports OpenCable & DVB-C
 – Recommended settings:

 – Parameters Constellation: 64 QAM
 – Remux(H/W) : Off

 – SIRCH Frequency should be matched to the SIRCH Channel of the TV.
 – If you change the frequency table, please refer to the frequency table in the SIRCH manual (Appendix A).
 – You should set same channel in both the SIRCH PC program and on the TV. For example. if you have 

an empty channel "2channel (57MHz)" in the Hotel, you should set 2channel(57MHz) for the SIRCH PC 
program and the TV.

 – Default initial value : SIRCH 87 (603MHz), TV SIRCH Channel : 87
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•	 Test version information while merging files into stream : 
 – To merge clone files ensure while merging SIRCH clone version in SIRCH PC program should be greater than 

the SIRCH version stored in TV.
 – To merge binary file ensure the binary merged into the stream has higher version than the binary already 

updated in TV.

 – TV SIRCH version should be less than SIRCH PC application value for update.
 – PC application: SIRCH Version (Clone): 0002, TV SIRCH Version: 0001. Update is possible. After update TV 

version will be set equal to SIRCH PC version, hence TV will be 0002.
 – PC application: SIRCH Version (Clone): 0002, TV SIRCH Version: 0002. Update is not possible.

 – Merge TV Binary : support to upgrade Main SW.
 – You need to contact Samsung to use Merge TV Binary.
 – Merge TV Binary cannot upgrade Sub Micom
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•	 Merged TS Stream should be located in D:\stream\OpenCable(US) or D:\stream\DVBC(EU)

 – You can check the SIRCH merged stream if you tune to the SIRCH channel.

 

 

 

 

[HC690-EUROPE]Install Guide-X0ENG.indd   76 2014-04-08   �� 11:20:56



77English

•	 Cautions for Hospitality mode options

 – Hospitality Mode: should be Standalone. – Interactive mode cannot support SIRCH.
 – Power On Source must be set to TV. If you select other external sources, SIRCH cannot support an upgrade.
 – If you try to upgrade SIRCH in external source (PC/HDMI…), SIRCH could not support upgrade by manual 

SIRCH / SIRCH Update Time.
 – SIRCH Upgrade Time: not off.
 – Dynamic SI should be set to ‘Off’ to modify the DTV display channel map in channel map tap. 

•	 Which all TV broadcasting standards are supported by the SIRCH application?
SIRCH application supports only ATSC and DVB .

•	  How to add channels for DVB /ATSC?
The user needs to select a particular TV region and model number. On basis of these parameters, the application 
adds channels for DVB (for EU) or ATSC (for US). Please refer section 2.7.

•	  What all broadcasting type SIRCH Modulator supports?
The SIRCH modulator supports only DVB-C (for DVB) and OpenCable (for ATSC) standards for broadcasting.

•	 What is difference between Channel in the channel map and Channel configured in SIRCH modulator?
 – Channels in the Channel Map are used watch channels on TV. We can add more than one channel in the 

channel map. This is in form of clone data and transfered using the seed stream. On other hand Channels 
configured in the SIRCH modulator are used for broadcast data (clone or binary) from the modulator with fixed 
frequency or channel numbers. This same channel number is used on the TV named the SIRCH channel for 
software update. (Please refer Appendix A). 
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Installing the Wall Mount

The wall mount kit (sold separately) allows you to mount the TV on the wall. For detailed information on installing the wall 
mount, see the instructions provided with the wall mount. Contact a technician for assistance when installing the wall 
mount bracket. We do not advise you to do it yourself.
Samsung Electronics is not responsible for any damage to the product or injury to yourself or others if you select to 
install the TV on your own.

Wall Mount Kit Specifications (VESA)

 ✎ The Wall mount kit is not supplied but sold separately.
Install your wall mount on a solid wall, perpendicular to the floor. When attaching to other building materials, please 
contact your nearest dealer. If installing on a ceiling or slanted wall, it may fall and result in severe personal injury.

 ✎ NOTE
•	 Standard dimensions for wall mount kits are shown in the table below.
•	 When purchasing our wall mount kit, a detailed installation manual and all parts necessary for assembly are 

provided.
•	 Do not use screws that do not comply with VESA standard screw specifications.
•	 Do not use screws longer than the standard dimensions, as they may cause damage to the inside of the TV set.
•	 For wall mounts that do not comply with the VESA standard screw specifications, the length of the screws may 

differ depending on their specifications.
•	 Do not fasten the screws too tightly. This may... damage the product or cause the product to fall, leading to 

personal injury. Samsung is not liable for these kinds of accidents.
•	 Samsung is not liable for product damage or personal injury when a non-VESA or non-specified wall mount is 

used or the consumer fails to follow the product installation instructions.
•	 Do not exceed a 15 degrees tilt when mounting this TV.

inches VESA Spec. (A * B) Standard Screw Quantity

28 100 x 100 M4

432~40 200 X 200
M8

48~55 400 X 400

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal injury due to electric shock.
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Securing the TV to the Wall

[
Caution: Pulling, pushing, or climbing onto the TV may cause the TV to fall. In particular, ensure that your children do not hang over or 
destabilize the TV; doing so may cause the TV to tip over, resulting in serious injuries or death. Follow all safety precautions provided on 
the included Safety Flyer. For added stability, install the anti-fall device for safety purposes, as follows.

To avoid the TV from falling 

1. Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the screws have been firmly 
installed onto the wall. 

 ✎ You may need additional material, such as an anchor, depending on the type of wall.
 ✎ Since the necessary clamps, screws, and string are not supplied, please purchase these additionally.

2. Remove the screws from the centre back of the TV, put the screws into the clamps, and then fasten the screws 
onto the TV again.

 ✎ Screws may not be supplied with the product. In this case, please purchase the screws of the following specifi-
cations.

3. Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong string and then tie the string 
tightly.

 ✎ NOTE
•	 Install the TV near to the wall so that it does not fall backwards.
•	 It is safe to connect the string so that the clamps fixed on the wall are equal to or lower than the clamps fixed on 

the TV.
•	 Untie the string before moving the TV.

4. Verify that all connections are properly secured. Periodically check connections for any sign of fatigue for failure. If 
you have any doubt about the security of your connections, contact a professional installer.

Anti-theft Kensington Lock

The Kensington Lock is not supplied by Samsung. It is a device used to physically 
fix the system when using it in a public place. The appearance and locking 
method may differ from the illustration, depending on the manufacturer. Refer to 
the manual provided with the Kensington Lock for additional information on proper 
use.
To lock the product, follow these steps:
Please find the “K” icon on the rear of the TV. A kensington slot is beside the 
“K” icon.

1. Wrap the Kensington lock cable around a large, stationary object such 
as desk or chair.

1

<Optional>

2. Slide the end of the cable with the lock attached through the looped end of the Kensington lock cable.

3. Insert the locking device into the Kensington slot on the product (1).

4. Lock the lock.
 ✎ These are general instructions. For exact instructions, see the User manual supplied with the locking device.
 ✎ The locking device has to be purchased separately.
 ✎ The location of the Kensington Lock may be different depending on the model.
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Specifications

Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

50°F to 104°F (10°C to 40°C)
10% to 80%, non-condensing
-4°F to 113°F (-20°C to 45°C)
5% to 95%, non-condensing

Model Name HG28EC690 HG32EC690 HG40EC690

Display Resolution 1366 x 768 1920 x 1080

Stand Swivel (Left / Right) 0˚ 20˚ / 60˚ / 90˚

Screen Size  (Diagonal) 28 inches 32 inches 40 inches

Sound (Output) 5W x 2 10W x 2

Dimensions (WxDxH)
Body
With stand

643.4 x 62.9 x 396.5 mm
643.4 x 163.4 x 435.1 mm

721.4 x 64.9 x 428.5 mm
721.4 x 192.6 x 465.6 mm

906.6 x 65.1 x 532.9 mm
906.6 x 226.5 x 577.6 mm

Weight
Without Stand
With Stand

3.7 kg
4.1 kg

5.0 kg
6.4 kg

7.8 kg
10.7 kg

Model Name HG48EC690 HG55EC690

Display Resolution 1920 x 1080

Stand Swivel (Left / Right) 20˚ / 60˚ / 90˚

Screen Size (Diagonal) 48 inches 55 inches

Sound (Output) 10W x 2

Dimensions (WxDxH)
Body
With stand

1075.1 x 65.5 x 627.6 mm
1075.1 x 226.5 x 673.5 mm

1230.6 x 64.0 x 718.4 mm
1230.6 x 226.5 x 762.8 mm

Weight
Without Stand
With Stand

11.1 kg
14.0 kg 

15.7 kg
18.6 kg

 ✎ Design and specifications are subject to change without prior notice.

 ✎ For power supply and power consumption information, refer to the label attached to the product.  
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Dimensions

 ▪ Front view / Side view

HG28EC690

 

1

2

53 6

7

8

1

2

4

53 6

7

8

4

(Unit: mm)

1 2 3 4 5 6 7 8

HG28EC690 643.4 609.5 347.0 311.4 396.5 435.1 62.9 163.4

HG32EC690 / HG40EC690 / HG48EC690 / HG55EC690

 

1

2

53 6

7

8

1

2

4

53 6

7

8

4

(Unit: mm)

1 2 3 4 5 6 7 8

HG32EC690 721.4 700.4 394.8 450.8 428.5 465.6 49.1 192.6

HG40EC690 906.6 887.6 500.2 556.5 532.9 577.6 49.3 226.5

HG48EC690 1075.1 1056.1 594.9 556.5 627.6 673.5 49.7 226.5

HG55EC690 1230.6 1209.6 680.4 556.5 718.4 762.8 64.0 226.5
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 ▪ Jack panel detail / Rear view

HG28EC690

(Unit: mm)

1 2 3 4 5 6 7 8

HG28EC690 100 100 271.7 140.5 147.3 78.7 113.5 392.4

HG32EC690 / HG40EC690 / HG48EC690 / HG55EC690

86

7

5

(Unit: mm)

1 2 3 4 5 6 7 8

HG32EC690 200 200 260.2 95.9 176.5 114.2 110.5 477.7

HG40EC690 200 200 352.8 124.0 195.4 156.3 196.9 620.8

HG48EC690 400 400 337.0 73.6 262.8 177.5 223.3 768

HG55EC690 400 400 414.8 150.2 336.0 228.2 238.1 872.8
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 ▪ Base Stand detail

HG28EC690 / HG32EC690

(Unit: mm)

311.4

163.4 122.5

HG40EC690 / HG48EC690 / HG55EC690

(Unit: mm)

556.5

149.5

R9.5 R3.8
135

152

67

NOTE: All drawings are not necessarily to scale. Some dimensions are subject to change without prior notice. Refer to the 
dimensions prior to performing installation of your TV. Not responsible for typographical or printed errors.
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Contact SAMSUNG WORLDWIDE

If you have any questions or comments relating to Samsung products, please contact the SAMSUNG customer care center.

Country Customer Care Centre Web Site

AUSTRIA 0810 - SAMSUNG (7267864, € 0.07/min) www.samsung.com
BELGIUM 02-201-24-18 www.samsung.com/be (Dutch)

www.samsung.com/be_fr (French)
BOSNIA 051 331 999 www.samsung.com
BULGARIA 07001 33 11 , share cost tariff www.samsung.com/bg
CROATIA 062 SAMSUNG (062 726 786) www.samsung.com/hr
CZECH 800 - SAMSUNG (800-726786) www.samsung.com

 Samsung Electronics Czech and Slovak, s.r.o. V Parku 2343/24, 148 00 - Praha 4
DENMARK 70 70 19 70 www.samsung.com
FINLAND 030-6227 515 www.samsung.com
FRANCE 01 48 63 00 00 www.samsung.com/fr
GERMANY 0180 6 SAMSUNG bzw. 

0180 6 7267864*
(*0,20 €/Anruf aus dem dt. Festnetz, aus dem Mobilfunk 
max. 0,60 €/Anruf)

www.samsung.com

CYPRUS 8009 4000 only from landline www.samsung.com/gr
GREECE 80111-SAMSUNG (80111 726 7864) only from land line

(+30) 210 6897691 from mobile and land line
www.samsung.com/gr

HUNGARY 06-80-SAMSUNG (726-7864) http://www.samsung.com/hu
ITALIA 800-SAMSUNG (726-7864) www.samsung.com
LUXEMBURG 261 03 710 www.samsung.com
MONTENEGRO 020 405 888 www.samsung.com
NETHERLANDS 0900-SAMSUNG (0900-7267864) (€ 0,10/Min) www.samsung.com
NORWAY 815 56480 www.samsung.com
POLAND 0 801-172-678* lub +48 22 607-93-33 **

*(całkowity koszt połączenia jak za 1 impuls według taryfy operatora)
** (koszt połączenia według taryfy operatora)

www.samsung.com/pl

PORTUGAL 808 20-SAMSUNG (808 20 7267) www.samsung.com
ROMANIA 08008 SAMSUNG (08008 726 7864)

TOLL FREE No.
www.samsung.com/ro

SERBIA 011 321 6899 www.samsung.com/rs
SLOVAKIA 0800 - SAMSUNG (0800-726 786) www.samsung.com
SPAIN 902172678 www.samsung.com
SWEDEN 0771 726 7864 (SAMSUNG) www.samsung.com
SWITZERLAND 0848 - SAMSUNG(7267864,  CHF 0.08/min) www.samsung.com/ch (German)

www.samsung.com/ch_fr (French)
U.K 0330 SAMSUNG (7267864) www.samsung.com
EIRE 0818 717100 www.samsung.com
LITHUANIA 8-800-77777 www.samsung.com/lt
LATVIA 8000-7267 www.samsung.com/lv
ESTONIA 800-7267 www.samsung.com/ee
TURKEY 444 77 11 www.samsung.com
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